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@SAFETY PRECAUTIONS @

(Read these precautions before using this product.)

Before using this product, please read this manual and the relevant manuals carefully and pay full attention
to safety to handle the product correctly.

The precautions given in this manual are concerned with this product only. For the safety precautions of the
programmable controller system, refer to the user's manual for the CPU module used.

In this manual, the safety precautions are classified into two levels: "AWARNING" and "ACAUTION“.

( )

é WARNING Indlcgtes.that incorrect handlllrjg may cause hazardous conditions,
resulting in death or severe injury.

Indicates that incorrect handling may cause hazardous conditions,
ACAUTlON resulting in minor or moderate injury or property damage.

\_ J

Under some circumstances, failure to observe the precautions under "A CAUTION" may lead to serious

consequences.
Observe the precautions of both levels because they are important for personal and system safety.

Make sure that the end users read this manual and then keep the manual in a safe place for future
reference.

[Design Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.




[Security Precautions]

/\WARNING

® To maintain the security (confidentiality, integrity, and availability) of the C Controller module and the
system against unauthorized access, denial-of-service (DoS) attacks, computer viruses, and other
cyberattacks from external devices via the network, take appropriate measures such as firewalls,
virtual private networks (VPNs), and antivirus solutions.

[Startup and Maintenance Precautions]

/\WARNING

@ For the following controls, configure an interlock circuit in the user program to ensure that the entire
system will always operate safely.
(1) Changing data of the running C Controller module from the development environment (personal

computer) connected

(2) Changing the operating status
(3) Operation from the development environment (personal computer)
Especially, in the case of a control from an external device to a remote C Controller module,
immediate action cannot be taken for a problem on the C Controller module due to a communication
failure.
To prevent this, configure an interlock circuit in the user program, and determine corrective actions to
be taken between the external device and C Controller module in case of a communication failure.

[Startup and Maintenance Precautions]

/\CAUTION

@ Before performing online operations (especially, program modification, forced output, and operation
status change) for the running C Controller module from the peripheral connected, read relevant
manuals carefully and ensure the safety.

Improper operation may damage machines or cause accidents.




@CONDITIONS OF USE FOR THE PRODUCT@®

(1) MELSEC programmable controller ("the PRODUCT") shall be used in conditions;

i) where any problem, fault or failure occurring in the PRODUCT, if any, shall not lead to any major or serious accident;

and

ii) where the backup and fail-safe function are systematically or automatically provided outside of the PRODUCT for the

case of any problem, fault or failure occurring in the PRODUCT.

(2) The PRODUCT has been designed and manufactured for the purpose of being used in general industries.
MITSUBISHI ELECTRIC SHALL HAVE NO RESPONSIBILITY OR LIABILITY (INCLUDING, BUT NOT LIMITED TO
ANY AND ALL RESPONSIBILITY OR LIABILITY BASED ON CONTRACT, WARRANTY, TORT, PRODUCT
LIABILITY) FOR ANY INJURY OR DEATH TO PERSONS OR LOSS OR DAMAGE TO PROPERTY CAUSED BY the
PRODUCT THAT ARE OPERATED OR USED IN APPLICATION NOT INTENDED OR EXCLUDED BY
INSTRUCTIONS, PRECAUTIONS, OR WARNING CONTAINED IN MITSUBISHI ELECTRIC USER'S, INSTRUCTION
AND/OR SAFETY MANUALS, TECHNICAL BULLETINS AND GUIDELINES FOR the PRODUCT.

("Prohibited Application")

Prohibited Applications include, but not limited to, the use of the PRODUCT in;

* Nuclear Power Plants and any other power plants operated by Power companies, and/or any other cases in which the
public could be affected if any problem or fault occurs in the PRODUCT.

» Railway companies or Public service purposes, and/or any other cases in which establishment of a special quality
assurance system is required by the Purchaser or End User.

« Aircraft or Aerospace, Medical applications, Train equipment, transport equipment such as Elevator and Escalator,
Incineration and Fuel devices, Vehicles, Manned transportation, Equipment for Recreation and Amusement, and
Safety devices, handling of Nuclear or Hazardous Materials or Chemicals, Mining and Drilling, and/or other
applications where there is a significant risk of injury to the public or property.

Notwithstanding the above restrictions, Mitsubishi Electric may in its sole discretion, authorize use of the PRODUCT in

one or more of the Prohibited Applications, provided that the usage of the PRODUCT is limited only for the specific

applications agreed to by Mitsubishi Electric and provided further that no special quality assurance or fail-safe,
redundant or other safety features which exceed the general specifications of the PRODUCTSs are required. For details,
please contact the Mitsubishi Electric representative in your region.

(3) Mitsubishi Electric shall have no responsibility or liability for any problems involving programmable controller trouble and
system trouble caused by DoS attacks, unauthorized access, computer viruses, and other cyberattacks.



INTRODUCTION

Thank you for purchasing CW Workbench.
This manual explains about the product.

Before using this product, please read this manual and the relevant manuals carefully and develop familiarity with the
functions and performance of CW Workbench and applicable modules to handle the product correctly.

Note that the menu names and operating procedures may differ depending on an operating system in use and its
version. When reading this manual, replace the names and procedures with the applicable ones as necessary.



RELEVANT MANUALS

The manuals related to the product are listed below.

Please place an order as needed.

Manual
<Manual No. and model code>

Description

C Controller Module User's Manual
(Hardware Design, Function Explanation)
<SH-080766ENG, 13J217>

The manual describes the system configuration, specifications,
functions, handling methods, wiring, and troubleshooting of Q12DCCPU-
V (Basic mode) and Q06CCPU-V.

C Controller Module User's Manual
(Utility Operation, Programming)
<SH-080767ENG, 13JZ18>

The manual describes the installation/uninstallation, utility operation,
instructions, and programming of Setting/Monitoring Tools for the C
Controller Module (SW3PVC-CCPU).

MELSEC-Q C Controller Module User's Manual
<SH-081130ENG, 13JZ75>

The manual describes the system configuration, specifications,
functions,handling methods, wiring, troubleshooting, and programming
and function of C Controller module (Q24DHCCPU-V, Q24DHCCPU-VG,
Q24DHCCPU-LS, Q26DHCCPU-LS, and Q12DCCPU-V (Extended
mode)).

Setting/Monitoring Tools for the C Controller Module
Operating Manual
<SH-081131ENG, 13JU76>

The manual describes the system configuration and operation method of
Setting/Monitoring Tools for the C Controller Module (SW4PVC-CCPU).

CW-Sim Operating Manual
<SH-081159ENG, 13JU77>

The manual describes the system configuration, specifications,
functions, and troubleshooting of CW-Sim.

Wind River Workbench 3.2 manuals

The manuals describe specifications, usage methods, troubleshooting,
and relevant documents of Wind River Workbench 3.2 that is the base
for this product.

Refer to the manuals for the same functions as Wind River Workbench.
A PDF file of the manuals is stored on the DVD-ROM disc of the product.
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MANUAL PAGE ORGANIZATION

The following illustration is for explanation purpose only, and should not be referred to as an actual documentation.

_Indicates the chapter of

I CHAPTER 8 CREATING AND BUILDING USER PROGRAM
currently open page.

3. select "C-Compiler" for "Build tool:".

Click the Tool Flags. button.

indicates
the useful tip.

L~

4. On the "Optimization" dialog box, select [Enable
maximum speed optimizations]. Check that "-02"
has been added to "Selected option:" and click the
0K | button. Indicates the section

3
v of currently open page.
=3
a3
o
2
El
15
&
o
2

O g

e
Point N Point £ indicates
oint .
1 the particular
To cancel the optimization option, click & | in "Enable Optimization" on "Optimization" and change the mark to .
& (cancel). Check that "-O™ has been deleted from "Selected option-" j attention.

<

To the next page
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Operating procedures
Three styles of descriptions are used in this manual as below:

(1) When there is only one operation

O Menu bar [Help]=>[Help Contents]

(2) When there are steps

1. Copy the created source file to the current folder of a project to be added.

2. Sselect the project to be added on the "Project Explorer” window.

(3) When there are multiple operations

» Enter a folder name of the installation location and click the k. button.

« Afolder can be selected by clicking the  Brows=.. | button.
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Symbols used in this manual

The following shows the symbols used in this manual with descriptions and examples.

& Basic Device Development — UserProject/Sample.c - C'W Workbench

File Edit Source

@— i -
ﬁ‘:, Project Explorer A

Refactor

Mavigate it Herdpr

N BRI

Search

Project References

Gloge Project

-l Build Targets (SHT7E0gnule)
s Wind River Launches

ﬁb Binaries

[l heludes

= SHT7EDenulz
[£] Samplec

aup Build Al
Build Project

Clean...

Build Options

Cpen Wind River Wiorks 6.4 Development Shell

% Properties for UserProject

bpofiortot ]

Resource
Binary Parzer

Build Properties

Specify all build properties.

@ Build Suppart and Specs | 4 Eulg Tooks $—Briid-Mmeros =Bt Faths |- s tibrares————————

Builders
® =+ /Tt General PEuild ool ‘C—Comp\ler v|[ MNew. ] [Rename ] [ Copy... ] [ Delete. ]
Project Info
Project References
Refactoring History Suffices %o |
RunsDebug Settings ’ )
Tosk Tags Build output generation
Validation (&) Generated build output is an object
O Generated build output is 3 build tarest
Build spec specific settines
fictive build spec [SH7750erle v

Derived suffix o |

Command: # |echo "building 3@ %ccompilerprefizi $TOOL PATH)ccsh ~
DebughodeF laesh $ToolFlassk §(ADDED CFLAGS) ¥lnchudesk =3
$CADDED IMCLUDES) -DCPU=FIGPLD - —
DTOOL_FAMILY=5TOOL_FAMILY! ~DTOOL=$(TOOL) ~D_WRS_KERNEL |~

Tool Flags. & ${CC_ARCHSPEC) —ansi -Wall -MD -MP

Debug mode flags

Debug mods 7 = \

Mon Debue mode..| @ -02 ~fro-builtin |

— ©

No. Symbol Description Example
@ [ ] Menu name on a menu bar [Project]

@ i Toolbar icon 6

® " Screen name or item name on a screen "Build tool:"
® << >> Tab name on a screen <<Build Tools>>
® Button on a screen

Keyboard key

Reference page

Reference manual




GENERIC TERMS AND ABBREVIATIONS

Unless otherwise specified, this manual uses the following generic terms and abbreviations.

Generic term/abbreviation

Description

Q24DHCCPU-V

The abbreviation for Q24DHCCPU-V C Controller module.

Q24DHCCPU-VG

The abbreviation for Q24DHCCPU-VG C Controller module.

Q12DCCPU-V

The abbreviation for Q12DCCPU-V C Controller module.

Q12DCCPU-V (Basic mode)

Status that Q12DCCPU-V is initialized with the basic mode For Q12DCCPU-V (Basic
mode), refer to the following manual.

[ 71 C Controller Module User's Manual (Hardware Design, Function Explanation)

Q12DCCPU-V (Extended mode)

Status that Q12DCCPU-V is initialized with the extended mode For Q12DCCPU-V
(Extended mode), refer to the following manual.

MELSEC-Q C Controller Module User's Manual

C Controller module

The generic term for Q24DHCCPU-V, Q24DHCCPU-VG, and Q12DCCPU-V.

Setting/monitoring tools for the C
Controller module

The generic term for Setting/monitoring tools for the C Controller module shown below.
* Q24DHCCPU-V, Q24DHCCPU-VG, and Q12DCCPU-V (Extended mode)
SW4PVC-CCPU
* Q12DCCPU-V (Basic mode)
SW3PVC-CCPU

VxWorks

The real-time operating system manufactured by Wind River Systems, Inc.

Wind River Workbench

The generic term for Wind River Workbench manufactured by Wind River Systems, Inc.

CW Workbench

The engineering tool for C Controller module.
The generic term for OEM products of Wind River without the runtime analysis tool and
simulation functions (VxSim) of Wind River Workbench; a subset of Wind River
Workbench.
* Q24DHCCPU-V and Q24DHCCPU-VG

SW1DND-CWWLQ24-E, SW1DND-CWWLQ24-EZ, SW1DND-CWWLQ24-EVZ
* Q12DCCPU-V

SW1DND-CWWLQ12-E, SW1DND-CWWLQ12-EZ, SW1DND-CWWLQ12-EVZ

VxSim

The generic term for the VxWorks simulator functions of Wind River Workbench.

CW-Sim

The abbreviation for the VxWorks simulator that can operate the C Controller module
program on a personal computer with CW Workbench installed, without connecting to the
actual machine (target).

CW-Sim Standalone

The abbreviation for the VxWorks simulator that can operate C Controller module
program even on a personal computer without CW Workbench installed.

Personal computer

. . ®
The generic term for personal computers where Windows operates

11



TERMS

Unless otherwise specified, this manual uses the following terms.

Term Description

The generic term for bus interface function, MELSEC data link function, and C Controller

Dedicated function library . .
module dedicated function.

Dedicated function library offered by C Controller module.

This function is used when executing the following:

Bus interface function * Input from or output to I/O modules controlled by the C Controller module
* Access to the buffer memory of an intelligent function module

* The readout or control of the C Controller module status

Dedicated function library offered by C Controller module.
MELSEC data link function This function is used when writing to/reading from a device of other programmable
Controller CPUs connected via network or configured with multiple CPUs.

Dedicated function library that controls C Controller module.
This function is used when reading the C Controller module status, controlling LED, and
C Controller module ) .
accessing to resources such as time and battery backup RAM.
This function can be used for Q24DHCCPU-V and Q24DHCCPU-VG C Controller modules.

It can not be used in Q12DCCPU-V C Controller module.

The abbreviation for Uniform Resource Locator.
URL This address indicates a location of information resources (such as text and images) on the

dedicated function

Internet.

Eqli An open source software development environment comprising an integrated development
clipse . . .
environment written in Java

PRODUCT ORGANIZATION

The following shows the C Controller-compatible software.
O: Applicable, X: Not applicable

C Controller
Q24DHCCPU-V
Q12DCCPU-V
Supported Q24DHCCPU-VG
software Earlier than
- "15102" or later *1
"15102" *1

- Extended mode Basic mode *2
SW1DND-CWWLQ24-E O X X X
SW1DND-CWWLQ12-E X O O @)

*1 First five digits of serial number
*2 For Q12DCCPU-V earlier than "15102", the mode cannot be changed. Q12DCCPU-V earlier than "15102" is regarded
as the basic mode in this manual.



CHAPTER 1 OVERVIEW

CHAPTER 1 ovErRVIEW

CW Workbench is a product for customers who develop a user program that operates on the C Controller module.
CW Workbench is an OEM product of Wind River Systems, Inc. The product has only basic functions required for user
program development, such as coding, building, and debugging, as a subset product of Wind River Workbench 3.2.

1 .1 Features

Engineering tool for C Controller, CW Workbench, is software to offer dedicated integrated development environment
for the Mitsubishi C Controller module.
CW Workbench has the following features:

(1) Software to offer dedicated integrated development environment for the C

Controller module
This product is an integrated development environment to execute the following operations: project management,
source code editing, building, and debugging. A user program for the C Controller module can be effectively

developed.

(2) The same specifications as those of Wind River Workbench 3.2
Displays and operations of CW Workbench are the same specifications as those of Wind River Workbench 3.2 for

common functions.

(3) Extended functions using plug-in software
The third party plug-in software can be easily added, which allows functions to be easily extended.

saimead ||

13



Memo

14



CHAPTER 2 SYSTEM CONFIGURATION

CHAPTER 2 sYSTEM CONFIGURATION

2.1 Environment Configuration for Each License Type

This section explains the environment for developing user programs in CW Workbench.

A permanent license is required to install CW Workbench. ([ Page 23, Section 5.1)

(1) Product with license

C Controller module

Permanent
License
Application Form

Permanent
license
file

o

CW Workbench
CW Workbench (SW1DND-CWWLQ12-E,
User program creating and building SW1DND-CWWLQ24-E)

(2) Additional license product

C Controller module
Permanent Permanent
_— S license License
file Application Form

CW Workbench
(SW1DND-CWWLQ12-EZ)*'

CW Workbench
(SW1DND-CWWLQ12-EZ)*?

adA ]| esusol yoeg Joy uoneinBiuo) JUSWUOIIAUT |°Z

@

CW Workbench
User program creating and building CW Workbench
(SW1DND-CWWLQ12-E,
SW1DND-CWWLQ24-E)

*1 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ12-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ12-
E) is required.

*2 The DVD-ROM is not included with the CW Workbench additional license product (SW1DND-CWWLQ24-EZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license (SW1DND-CWWLQ24-
E) is required.

15



(3) Updated license product

C Controller module C Controller module
(Q12DCCPU-V)*2

Ethernet

User program debugging User program debugging
(SW1DND-CWWLQ12-E) (SW1DND-CWWLQ24-E)

Permanent
license <:|
file

CW Workbench Iﬁ
(SW1DND-CWWLQ24-EVZ)*'

o

Permanent
License
Application Form

CW Workbench
User program creating and building CW Workbench
(SW1DND-CWWLQ12-E*2+ SW1DND-CWWLQ24-E) (SW1DND-CWWLQ12-E)

*1 The DVD-ROM is not included with the CW Workbench updated license product (SW1DND-CWWLQ24-EVZ).
To install CW Workbench, the DVD-ROM included with the CW Workbench product with license

(SW1DND-CWWLQ12-E) is required.
*2 The configuration before installing the updated license product (SW1DND-CWWLQ24-EVZ) is indicated.

Point/

If the CPUs to be used after update are not written in "Target CPU" of Permanent License Application Form, please consult
your local Mitsubishi representative.

16



CHAPTER 2 SYSTEM CONFIGURATION

2.2 Relevant Module

CW Workbench is compatible with the following C Controller module:

Model Operating System Relevant software package
Q24DHCCPU-V SW1DND-CWWLQ24-E
VxWorks 6.8 SW1DND-CWWLQ24-EZ
Q24DHCCPU-VG SW1DND-CWWLQ24-EVZ

SW1DND-CWWLQ12-E
Q12DCCPU-V VxWorks 6.4 SW1DND-CWWLQ12-EZ
SW1DND-CWWLQ12-EVZ

2.3 Operating Environment

Below is a list of the operating environment of a personal computer where CW Workbench can be operated.

Item Description
PC/AT-compatible personal computer in which the following operating systems can be
Computer
operated.
Windows 11 2 or more cores on a compatible 64-bit processor or System on a Chip (SoC)
CPU

Windows 10 | Intel°Core™2 Duo 2GHz or higher is recommended.

Windows 11 4G bytes or more

Memory requirements

Windows 10 | 1G byte or more (2G bytes or more is recommended)

Install size: HDD 4G bytes or more

Hard disk space . )
Executable size: Virtual memory 512MB or more

Display 1024-by-768 resolution or higher B
Disk drive DVD-ROM drive §

<
Interface Ethernet 10BASE-T/100BASE-TX/1000BASE-T 3
0Ss 1727345 * Windows 11 (Home, Pro, Enterprise, Education) =
(Japanese/English) » Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB*G) %

*1 When the following functions are used, this product may not run properly.

« Application start-up in Windows compatibility mode

« Fast user switching

* Remote desktop

* Touch function

* Tablet mode

« Virtual Desktops

» Text cursor indicator
*2 In the following cases, the screen of this product may not work properly.

* The size of the text and other items on the screen is other than 100% (96 DPI, 9 pt etc.).
*3 Log on as a user with the Administrator attribute when installing and uninstalling CW Workbench.
*4 TCP/IP is required.
*5 The FTP server included in CW Workbench cannot be used.

For using the FTP server, use Microsoft Internet Information Services.
*6 64-bit version only.

17



2.4 Specifications
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Below are specifications of CW Workbench.

Item

Specifications

Product name

CW Workbench

Operating system of applicable host
machine

Refer to "Operating environment"({__=  Page 17, Section 2.3)

Applicable C Controller module

Refer to "Relevant Module".(__ Page 17, Section 2.2)

Applicable operating system

Q24DHCCPU-V
VxWorks 6.8

Q24DHCCPU-VG

Q12DCCPU-V VxWorks 6.4

Framework

Wind River Workbench 3.2 base (Eclipse3.5)

Project creation and management

VxWorks Downloadable Kernel Module Project

Building

Q24DHCCPU-V

GNU compiler (GCC 4.1.2 for Intel Atom Z5xx)
Q24DHCCPU-VG

Q12DCCPU-V GNU compiler (GCC 3.4.4 for SH-4A)

Debugger

» Debugging execution restart

» Debugging execution forced stop

« Breakpoints

« Step through execution

« Variables/structure variables reference and editing
* Register value reference and editing

» Memory block reference and editing

« Target connection agent

» Dynamic Printf (Q24DHCCPU-V/-VG only)

License format

Node locked

Document

Wind River Workbench 3.2 Help document




CHAPTER 3 PACKING LIST

CHAPTER 3 PACKING LIST

3.1

Packing List

The following items are included with CW Workbench. Check that all the items are included before use.

(1) Items included with CW Workbench

Model name

Item

Qty.

(Product with license)
SW1DND-CWWLQ12-E
SW1DND-CWWLQ24-E

DVD-ROM([_ = Page 19, Section 3.1 (2))

"Before Using the Product”

License Certificate

End-User Software License Agreement

Permanent License Application Form (sample)

(Additional license product ")
SW1DND-CWWLQ12-EZ
SW1DND-CWWLQ24-EZ
(Updated license product ")
SW1DND-CWWLQ12-EVZ
SW1DND-CWWLQ24-EVZ

"Before Using the Product”

License Certificate

End-User Software License Agreement

Permanent License Application Form (sample)

*1 The DVD-ROM is not included with the CW Workbench additional license product or updated license product. To install
CW Workbench, the DVD-ROM included with the CW Workbench product with license is required.

(2) Contents of CW Workbench DVD-ROM

Content Description Storage location
\
CW Workbench install image | An install image file of CW Workbench )
\images
Relevant manuals of VxWorks and Wind River Workbench 3.2 \docs

Relevant document

(PDF)

A license notice (PDF) of the third party used in CW Workbench

\3rd_party_licensor_notices

Manual CW Workbench Operating Manual (PDF) \manual
An application form for a permanent license and a license transfer.
Permanent License (PermanentLicenseApplicationForm.xIsx) \
Application Form Use the form when applying for a permanent license and a license
transfer.
Afile to be used as an install key when you do not have a
. permanent license file and do not have the Internet.
Install key file . . . \
CW Workbench operates with no license when having been
installed using an install key file (Install_SH_IA.txt).
CW Workbench .
A CW Workbench open source file \src

open source file

19
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3.2

Things to Prepare

20

The following lists things to prepare before using CW Workbench.

(1)

(2)

()

(4)

()

Development environment (personal computer)

Prepare a personal computer to install and use CW Workbench.

. 0O
Point >
Enter the host name within 2 to 15 alphanumeric characters for a personal computer to be used as a development

environment (personal computer).
Operating Environment for operating specifications of a personal computer.([__= Page 17, Section 2.3)

CW Workbench DVD-ROM

Prepare a CW Workbench DVD-ROM included with the product with license (SW1DND-CWWLQ12-E,
SW1DND-CWWLQ24-E).

The DVD-ROM is required to install CW Workbench. Apply for a permanent license using an application form
stored on the DVD-ROM.

License Agreement

An LAC described in the License Agreement is required to install CW Workbench by using a temporary license.
An LAC and a product ID described in the License Agreement are also required to apply for a permanent license.
Prepare the License Agreement included with CW Workbench.

Permanent license file

A permanent license file is required to install CW Workbench by using a permanent license.
To acquire a permanent license file, use a Permanent License Application Form stored on the DVD-ROM and
send us the Form.

Internet connection

An Internet connection is required to install CW Workbench by using a permanent license.
Acquire a 31-day temporary license via the Internet.



CHAPTER 4 PROCEDURE OVERVIEW

CHAPTER 4 PROCEDURE OVERVIEW

4.1 From Installation to Debugging

Obtain a permanent license.
Apply for a permanent license.

[ 5 Page 23, Section 5.1

Installation
How do you install the product?

| ‘ | ‘ |
[C_ 5 Page 28, Section 6.1

e b Pege P e

Apply a permanent license.
Apply a permanent license that is sent later to the development
environment (personal computer).

[ = Page 26, Section 5.3

Use the permanent license file for Use the temporary license file for Use the install key file for
installation installation. installation. 1

Internet Connection: Yes Internet Connection: No 1

[ Page 21, Section 4.1 (1) ) [ = Page 21, Section 4.1 (2) [ Page 21, Section 4.1 (3) '

J '

)

, Permanent License File: Yes Permanent License File: No Permanent License File: No

v
To the next page

(1) Installation using a permanent license

This installation is for users with a permanent license (regular license). All the functions of CW Workbench can be

Buibbngaq 0} uone|eIsu| Wol4 L'y

used for unlimited duration.

(2) Installation using a temporary license

This installation is for users with a temporary license acquired on the Internet. All the functions of CW Workbench
can be used for 31 days after the installation.

(3) Installation using an install key on the DVD-ROM

This installation is for users having neither permanent license nor Internet connection.
Only the editor, import, and export functions of CW Workbench can be used. The build, compile, or debug
functions cannot be used.
Note that for SW1DND-CWWLQ24-EVZ, the installation using the following install key files cannot be executed.
* Install_SH4.txt of SW1DND-CWWLQ12-E
* Install_SH_IA.txt of SW1DND-CWWLQ24-E

21



The dialog box shown to the right appears when
CW Workbench is started up with no license.
Click Cancel to continue the operation.

From the previous page

!

FLEXIm License Finder
“Your application was not able to ohtain a license
becauze the FLEXIm license manager could not

determing where to find the licensing data it
needs. Please choose one of the following

(%) Specify the License Server
) Specify the License File

Copyright (5] 1338, 20103 Macrovision Corporalion

Apply a patch.
Information and services

For further information and services, please consult your local Mitsubishi representative.

[~ 5 Page 53, CHAPTER 7

Create a project.

Create a user program project and perform programming.

[ 5 Page 56, CHAPTER 8

Build.
Build a user program.

[ = Page 70, Section 8.3

Connect the target.
Connect CW Workbench to the C Controller module.

[ >~ Page 76, CHAPTER 9

Download.
Download the user program on the C Controller module.

[ 5 Page 84, CHAPTER 10

Debug.
Debug the user program.

[ = Page 84, CHAPTER 10

22




CHAPTER 5 PERMANENT LICENSE

CHAPTER 5 PERMANENT LICENSE

5.1 Obtaining Permanent License

A permanent license is required to use CW Workbench for unlimited duration. Follow the instructions shown below to

obtain a permanent license.

Start obtaining a permanent license.

:

Obtain a Permanent License Application
Form on the DVD-ROM.

!

Obtain host information on the development
environment (personal computer) where
CW Workbench is used.

E? Refer to the Permanent License Application Form (sample)
included with the product for how to acquire host machine
information.

N\ /
4 N\
E:? Refer to the Permanent License Application Form (sample)
Fill out the Permanent License Application included with the product for how to fill out the form.
Form.*! Directly enter information on the Application Form stored on
the DVD-ROM (PermanentLicenseApplicationForm.xIsx on
L J the Permanent License Application Form).

e N —

Send the Application Form to the address >
described on the form. MAIL

Permanent License

Application Form

\_ / Will be replied

\ from the address
| you sent it to

- D
A permanent license file will be e-mailed If’ermangnt
to you. MAIL license file

o / -

4 N\

Apply the permanent license file to the
development environment (personal
computer).

[ F Page 26, Section 5.3

!

Completed.

*1 For the development environment (personal computer) information on the Permanent License Application Form for the
updated license product, enter the same information as the one registered to acquire the permanent license previously.

23
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5.2 License Transfer

Another permanent license is required on a new development environment (personal computer) for license transfer
due to reasons such as when the development environment (personal computer) where CW Workbench has been
installed crashed.

Follow the instructions shown below for license transfer.

Start license transfer.

Has the
. No
development environment
(personal computer)
crashed?
v

ves ; Page 41, Section 6.2
Uninstall CW Workbench on the current [Z = Page 41, Section 6.
development environment (personal
computer).

A

[ Page 27, Section 5.4

Delete the current permanent license
file.

(Delete the permanent license file
saved as a backup file as well.)

l

Obtain a License Transfer Certification
Agreement Form on the DVD-ROM.

l

Obtain host information on the development
environment (personal computer) where
CW Workbench is used.

|

To the next page

For how to obtain host information, refer to
the Permanent License Application Form
(sample).
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CHAPTER 5 PERMANENT LICENSE

From the previous page

!

~
E:? Directly enter information on the License Transfer
Fill out the License Transfer Certification Certification Agreement Form stored on the DVD-ROM
Agreement Form. (PermanentLicenseApplicationForm.xIsx on the License
Transfer Certification Agreement Form).
.
N
Fax the License Transfer Certification FAX
Agreement Form with your signature to
your local Mitsubishi service center or |
representative where you purchased .
the product. License Transfer
) Certification Agreement
! Will be replied
H from the address
' you sent it to
) Permanent
A permanent license file will be e-mailed o MAIL license file
to you. —
.
N
Install CW Workbench on the new E? Page 28, Section 6.1
development environment (personal
computer) using the new permanent
license.
/

!

Completed

If you have lost the License Agreement and do no know the Product ID, contact your local Mitsubishi service center or
representative and give them information filled out on the Permanent License Application Form.

» Name of the representative person, department name, and company name

* E-mail address

+ Target CPU

Jajsuel] 8susol] Z'G

25



5.3 Applying Permanent License

Apply the acquired permanent license file to the development environment (personal computer) specified for "Host
machineinformation" on the application form.
Follow the instructions shown below to apply the permanent license file.

Start applying a permanent license.

Yes
CW Workbench is running.
v
No
Terminate CW Workbench.
v
[ 5 Below is alicense folder when CW Workbench is installed
on the C drive without changing the folder of the installation
Copy the obtained permanent license file location.
on the license folder of CW Workbench.*' C:\WindRiver\license
Note: Do not store the license file in folders other than the one
specified above and use the file when applying the license
file to the development environment (personal computer).
v
Start CW Workbench.
Completed

*1 When two or more permanent license files are obtained with the updated license product, overwrite all files.
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CHAPTER 5 PERMANENT LICENSE

5.4 Deleting Permanent License

Follow the instructions shown below to delete the current permanent license for license transfer.

Start deleting the permanent license.

Yes
CW Workbench is running.
No
Terminate CW Workbench.
v
/ N\
E? Delete all the files in the license folder of CW Workbench.
C:\WindRiver\license
Completely delete the permanent license
file from the license folder of CW
Workbench.
(Delete the permanent license file saved
as a backup file as well.)
- /

v

Completed

asue9lT Jusuewlad bunsieq '
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CHAPTER 6 INSTALLATION AND
UNINSTALLATION

6.1 Installation

This section explains how to install the product, how to operate, and precautions.

6.1.1 Preparation before installation

(1) Log on as a user with the Administrator attribute when installing the product
on the development environment (personal computer).

(2) Insert the DVD-ROM into the development environment (personal computer),
the installer automatically starts.

When a screen to play DVD automatically appears, select "Run wscript.exe".

If the installer does not automatically start, double-click "Install.vbs" on the DVD-ROM to start it.

Do not execute more than one "Install.vbs" at the same time, or the product may not be properly installed. If the
installation was not completed properly, uninstall the product and execute "Install.vbs" again.

(3) The confirmation dialog box of User Account Control appears. Click "Allow" or
[Yes] button to continue the installation.
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

(4) Acquire a permanent license file.
If you require the Permanent License Application Form, or if you have purchased the updated license
product, please consult your local Mitsubishi representative.

Point/’

Stop all other applications running on Windows before installation.

The installer may not operate the functions properly due to the automatic start of update programs of the operating
system or any other software, such as Windows Update or Java Update. Change the setting to disable the automatic
start of update programs before installation.

CW Workbench cannot be over-installed on the development environment (personal computer) where CW Workbench
has been already installed. Uninstall the product before reinstallation.

Do not install the product on the development environment (personal computer) where Wind River Workbench has been
already installed. To install the product, uninstall Wind River Workbench or prepare another development environment
(personal computer).

When the product is installed by using a temporary license, the product operates for 31 days. A regular license is issued
after a permanent license is obtained. Use the permanent license to start the product.

$lLxenzcitoliizand &) The license error message shown below appears after 31
@ B e 1212410 cbtan e days. The product continues to operate by clicking the
Feature has expired . . o
E;g::*;zmh e Cancel | button, but the project creation, compiling/

icenze patl
# licenze fle path is decerived building, and debug functions cannot be used.
555?2"‘52%7%w@%iéz;;:::;;m“Ex'm Fr e entel [License error message]
Error text: "Feature has expired
Error code: -10

To install CW Workbench using a temporary license, it can be obtained via the Internet. Before installation, check that the
personal computer can be connected to the Internet.

If the personal computer is connected to the Internet via a proxy server, check the IP address and port number in
advance. They are required to be set during installation.

Note the following when installing the updated license product.
» Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to LAC
on the User Information window.
* The updated license product (SW1DND-CWWLQ24-EVZ) cannot be installed with the install key file
(Install_SH4.txt) of the product with license (SW1DND-CWWLQ12-E).

CW Workbench 3.2 (this product), CW Workbench 3.3, and CW Workbench 4 can be installed on the same development
environment. Note that, when installing CW Workbench 3.2 (this product) on a personal computer where CW Workbench
3.3 or CW Workbench 4 is installed, install it to a different folder from the one where CW Workbench 3.3 or CW
Workbench 4 is installed. Additionally, CW Workbench3.2 (this product), CW Workbench3.3, and CW Workbench 4
cannot be started at the same time.

29
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6.1.2

How to install CW Workbench

Start installing CW Workbench

W Extract Installer

Wind River recommends installing different products including versions in their own folder
to avoid any individual file versioning izsues. |f you have a specific situation where you

heed ta install rmultiple products [or versionz] in the same location, pleaze contact Suppart
for additional guidance as zome versions and products are designed to be installed in the

same location. Select the install location:
Browse... I
Ok I Cancel I

Insert the CW Workbench DVD-ROM into the DVD drive
to start the installer.

1. After the installer is started, execute one of the

following operations and click the [OK] button:
» Enter a folder name of the installation
location.
+ Click the [Browse] button to select a
folder of the installation location from the
tree view.

Point/’

@ The following characters can be used for a folder name of the installation location: (Space cannot be used.)

» Alphanumeric characters
* Hyphen "-"
* Underscore "_"

The product cannot be properly installed if characters other than those described above are used for a folder name.

284
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Wind River Instaler:
Wind River Workbench 3.2 for Mitsubishi C Controllers

WIND"

To the next page

2. Click the [Next] button.



CHAPTER 6 INSTALLATION AND UNINSTALLATION

3. Click the [Next] button.

To update the installer, select the checkbox of "Check for and apply
e sl frecesn) installer updates (installer restarts if necessary)". The latest installer

[0 Check onlin for the ltest Wind River product updates.

+ NeworkSetings is downloaded and updated online.

W Instaler - Online Update Settings

WIND"

Point/’

When the personal computer is connected to the Internet via a proxy server, click "Network Settings" and select the
checkbox of "Connect to the Internet using a proxy server", and configure the proxy server set for the Internet connection.
In addition, the Internet connection status can be checked by clicking the [Test Internet connection] button.

WIND®

uopejesu| L9

4. To continue the installation, select one of the

following procedures:
If the permanent license file is not obtained
* Installation using a temporary license (a personal computer
e —— can be connected to the Internet):
= (1)[Z5~ Page 32
* Installation using an install key on the DVD-ROM (a
personal computer cannot be connected to the Internet):
= (1) L7 Page 34
If the permanent license file is obtained
* Installation using a permanent license

=>(1)[5 Page 35

4OUSGHIOM MO [[BISUI O) MOH 2'}'9

WIND"

Help. < Back Next > Cancel
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Installation using a temporary license

(1) Select "Temporary activation (requires License

Authorization Code and Internet connection)" and click

EQ :Tywmw the [Next] button.
Z
2

Help < Back Next > Cancel

Point /S’

@ If "Temporary activation (requires License Authorization Code and Internet connection)" is selected, the Internet is
required to acquire a temporary license. Execute the installation on a personal computer connected to the Internet.

@ If the personal computer is connected to the Internet via a proxy server, configure the proxy server setting. (_3  Page
31 Point)
If "Temporary activation (requires License Authorization Code and Internet connection)" is selected without configuring
the proxy server setting, installation does not proceed.

® When using the installer with software version "F" or earlier, a temporary license cannot be acquired. For installation,
use the latest installer with a temporary license acquired, an installation key file, or a permanent license.
Check the software version with the alphabet at end of the character string written in the DATE column of a DVD-ROM.
(Example: 1710AF indicate that the software version is "F".)

(2) Check the content of "Note" on the window. Select
either "Ethernet Adapter” or "Disk Serial Number" for
the Host ID and click the [Next] button.

Selection  HostID Type
® Ethernet Adapter
o Disk Serial Number

Note: Host s
your hard disk seial number as your host ID nstead.

-
=
3

Hep < Bock Nedt > Gancel

284

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

(3) Enter a License Authorization Code (LAC) and user

O aren—

information listed below and click the [Next] button.

“Zip/Postal Codes | ay | |

e — <

WIND"

Point/’

Use alphanumeric characters for the LAC and user information.
(Items with a * mark on the window must be entered correctly.)

LAC: License Authorization Code
' (described in the License Agreement included with CW Workbench)

User Name: User name

Company: Company name

Address1: Address (such as town name and block number)

Address2: Building name, etc. (can be left blank)

E-mail: E-mail address

Phone: Phone number

Zip/Postal Code: Zip code

City: City

State/Province: State ®

Country: Country 5
(2]
g
g
=
]

<

= (2) [ Page 35
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Installation using an install key on the DVD-ROM

(1) Select "Permanent activation", click the [Browse]
button, specify the following install key file stored on the
DVD-ROM, and click the [Next] button.

34

% & For Q24DHCCPU-V/-VG: "Install_SH_IA txt"
i e ——— 2> For Q12DCCPU-V: "Install_SH4.txt"
RS
Point />

When the installation is executed with specifying the install key file, CW Workbench is installed without license and only the
following functions can be used:

« Editor function (such as creation, editing, saving, and searching)

* Import/Export
To use all the functions of CW Workbench, obtain and apply a permanent license.
[ 5 Page 23, Section 5.1

[ 5 Page 26, Section 5.3

28
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Installation using a permanent license

WIND"

@ Permane
Enter the fullpath to your product activation file:

O Manually ente all installation key=

W installer - Typical or Custom

WIND"

m EAPINSNE——

Typical

Instal standard features with altarget architectures.

a Custom

CHAPTER 6 INSTALLATION AND UNINSTALLATION

(1) Select "Permanent activation" and click the [Browse]
button.
Select the permanent license of the product to be
installed from the tree view. Then click the [Next] button.

<

(2) To continue the installation, select one of the following
procedures:

» When selecting "Typical": = (1) [ 7 Page 36
» When selecting "Custom": &> (1) [ Page 37

35
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When selecting "Typical"
(1) Click the [ ACCEPT] button.

By clicking "l ACCEPT", you consent to the terms of these agreements. If you do not wish to be bound by the terms of these agreements, click
Cancel and do not install this software.

ey Py IF YOU HAVE SIGNED A WRITTEN AGREEMENT WITH WIND ,
> Wind River License 2 RIVER FOR THE PRODUCT PROVIDED TO YOU ON THIS DISC
THE TERMS OF SUCH WRITTEN AGREEMENT WILL SOLELY
GOVERN YOUR USE OF SUCH PRODUCI. IF YOU HAVE
RECEIVED A PRODUCT WITHOUT ENTERING INTO A WRITTEN
LICENSE AGREEMENT WITH WIND RIVER SYSTEMS, YOUR USE
OF SUCH PRODUCT SHALL BE SOLELY GOVERNED BY THE
PRODUCT EVALUATION LICENSE AGREEMENT BELOW.

PRODUCT EVALUATION LICENSE AGREEMENT

THIS PRODUCT  EVALUATION ~LICENSE ~ AGREEMENT
("Agreement”) is a legal contract between Customer (*Customer”
or "you") and Wind River Systems, Inc, ("Wind River"). The right
t0 use the Product is granted only on the condition that Customer
agrees to the following terms. If Customer does not agree to the
torms of this Agreement, then Wind River and its licensors are
unwilling to license the Software to Customer and you may not
install the Product.

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE
PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL TREATY. UNAUTHORIZED USE,
REPRODUCTION OR DISTRIBUTION IS SUBJECT TO CIVIL AND
‘CRIMINAL PENALTIES.

PLEASE READ THE TERMS CAREFULLY BEFORE CLICKING ON
THE "I ACCEPT" BUTTON, AS BY CLICKING ON THE " | ACCEPT"
BUTTON YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
T, UNDERSTAND IT AND AGREE TO BE BOUND BY

v

284

(2) Click the [Finish] button.

=
£
D m P——

Typical
Instalstandard features with alltarget architectures.

F

Installation successful.

Please see readme for detalsor clic Finish to ext the installr:

Help < Back Fiish Cancel

1S4

Completed
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When selecting "Custom"

W Installr - Instal o Download

a
Click Help below for details.
@ nstall

O Localdownload copy media to host)

WIND"

Terget Architectures:
target. If you are uncertain, you may select ll of
them
Ointel Selectall
O supertt
Deselectal

WIND"

H
5 Select Products A Show Installed Content
e =
e i C Contrll
> &40
> i &80
> in Works 68 412
2o 2010
> 2@ 3.2 for VxWorks 6.8 (Enabler Rev 3) 320
> I Wind River Workbench Core 32.03 220

Installtion Directory
[2

1.3 GB (167,32 GB available)
483,64 M8 (local media)

To the next page

CHAPTER 6 INSTALLATION AND UNINSTALLATION

(1) Check that "Install" is selected, and click the [Next]
button.

(2) Click the [Deselect all] button.

(3) Select the following items, and click the [Next] button.
* For Q24DHCCPU-V/-VG: "Intel"

» For Q12DCCPU-V: "SuperH"

(4) Check that the checkboxes of all items are selected,
and click the [Next] button.

37
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(5) Select "I ACCEPT the terms of these license
agreements." and click the [Next] button.

By selecting "I ACCEPT A

> Wind River License. IF YOU HAVE SIGNED A WRITTEN AGREEMENT WITH WIND
> Wind River License 2 RIVER FOR THE PRODUCT PROVIDED TO YOU ON THIS DISC THE
TERMS OF SUCH WRITTEN AGREEMENT WILL SOLELY GOVERN

DUCT

EVALUATION LICENSE AGREEMENT BELOW.
PRODUCT EVALUATION LICENSE AGREEMENT

THIS  PROI EVALUATION  LICENSE  AGREEMENT
[Agreement) is  egal contract between Customer ("Customer- or
River’). The right to

n that Customer
- If Customer doos nn( 2gres to the
Win and its licensors are
unwiling 10 license the. "ofwere 1o Costomer and you may not
install the Product.

WIND"

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE
PROTECTED BY UNITED

INTZRNATIONAL TREATY: UNAUTHORIZED,USE, HEPRODUCTION
&R DISYRIBHVION IS SUBJECT TO CIVIL AND CRIMINAL

PLEASE READ THE TERMS CAREFULLY BEFORE CLICKING ON
BY CLI

THE "1 ACCEPT" BUTTON, AS
BUTTON YOU ACKNOWLEDGE. THAT YOU WAVE READ. THS
AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.
1. DEFINITIONS. M
@1 ACCEPT the terms o these lcense agreemens
1100 NOT ACCEPT the terms of these icense agreements.
Help < Bk Next > Cancel

(6) Click the [Install] button.

H Products and Features
cick nsal.
[ Wind River Workbench 2.2 for Mitsubishi C Controlers.
> (3 VeWorks 6.41 Applicaton Developer &40
> [ WWorks 6.1 Applicaton Developer &80
> D8 Wind River GNU Compilr 1.2 for VxWorks 68 a2
08 Wind Rver Setup 201 2010
> [0 Wind Rivr Workbench 2.2 for VeWorks 68 Enable Rev 3) 220
> I8 Wind Rivr Workbench Core 3203 320
Installation Directory Shortcut Options
C¥WindRiver
Desktop shortcuts: +
Disk Space Information =
Instalation Sze 1.3 GB (1875 GB avalable) Startmenu entres: -
Download Size  483.64 MB (local media) frolies rae: Ll

[hep <Bock || sl |[ Concel

(7) Click the [Next] button.

(C]

Instaled content.

Filter products and features

H
b
M Wind River Workbench 32 for Mitsubishi C Controlers
> [ VeWorks 641 Applcaton Developer &40
> [ VeWorks 6.1 Applicaton Developer 880
> 3 Wind iver GNU Compiler.1.2 for aWorks 68 a2

0 Wind River Setup 201 2010
8 Wind River Workbench 3.2 for VWorks 68 (Enabler Rev 3) 220
> 8 Wind River Workbench Core 3203 220

G RS e

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

(8) Click the [Finish] button.

Completed

uopejesu| L9
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6.1 .3 After installation

This section explains an icon registration, sample programs, and a patch application after the product is installed.

(1) How to start CW Workbench
After CW Workbench is installed, "Wind River" is added in the Windows Start and the following menus will be

available.
Menu Description

CW Workbench Starts CW Workbench.
Starts Wind River Registry for Workbench 3.2.

Registry,3.2 When CW Workbench is started, Wind River Registry for Workbench 3.2 also starts, except
when it is running already. An icon is registered on the task tray.

Product Maintenance” Uninstalls and updates CW Workbench and applies a patch.
Starts WFTPD.

FTP Server?2 For available operating systems, refer to the following section.
[C_ 5 Page 17, Section 2.3

VxWorks COMx2 Starts HyperTerminal for Telnet connection.

xIvorks X This menu cannot be used when HyperTerminal is not installed.
VxWorks Development Shell 2 Starts a command line Shell in which the GNU compiler can be used.

*1: When installing this product on the environment where CW Workbench 3.3 is installed, the menu name is changed to
'Productmaintenance~0'".
To judge a target product, select "About This Installation" of Product Maintenance and check "Installed Content".
For CW Workbench 3.2 (this product) or CW Workbench 3.3, the target product is displayed as follows:
-CW Workbench 3.2: Wind River Workbench 3.2 for Mitsubishi C Controllers
-CW Workbench 3.3: Wind River Workbench 3.3 for Mitsubishi C Controllers
*2: The names of the menus are changed depending on the version of VxWorks.

VxWorks 6.4 VxWorks 6.8
FTP Server,6.4 FTP Server,6.8
VxWorks COMx,6.4 VxWorks COMx,6.8
VxWorks Development Shell,6.4 VxWorks Development Shell,6.8

(a) Sample programs to be registered
Sample programs provided by Wind River Systems, Inc. are installed when the product is installed on the
development environment (personal computer). To check the sample programs to be installed, start the product
and select from the file menu [New] => [Example...].
For details on the sample programs, refer to the Wind River Workbench document provided by Wind River
Systems, Inc.

O [Helplin the menu bar=>[Help Contents]=>"Wind River Documentation" — "Guides" — "Host
Tools" — "Wind River Workbench By Example(VxWorks 6 Version), 3.2"
If the SW4PVC-CCPU or SW3PVC-CCPU has been already installed on the development environment
(personal computer), the sample programs for the C Controller module can be imported to the product and
used.
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.2 Uninstallation

This section explains how to uninstall CW Workbench and precautions.

6.2.1 Preparation before uninstallation

(1) Log on as a user with the Administrator attribute when uninstalling the product
on the development environment (personal computer).

(2) Terminate the product before uninstallation.

(3) Uninstall the product in [Product Maintenance].

The product cannot be uninstalled from "Add or Remove Programs" in the Control Panel.

(4) Do not stop the processing during uninstallation. If the processing has been
stopped, uninstall the product again.

If the uninstallation processing has failed after the uninstallation processing has been stopped, reinstall the
product. Then uninstall the product again.

(5) The confirmation dialog box of User Account Control appears. Click "Allow" or
[Yes] button to continue the Uninstallation.

uoneelsuIun Z°9

uole|iejsulun alojeq uoneledald 129
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622 How to uninstall CW Workbench

Start uninstalling CW Workbench 1. Sstart Product Maintenance from [Wind River] in
Windows Start.

2. Select "Remove".

& 5can for Product Updates and Add-ons
s P S e e

=
b
Patch
Apply patches: indiidusl fices for individusl problems.

Configure

& Remove
[ it i Rver prodcts

@ About This Installation
¥ iver

License Configuration
Rl e e

Help
Open contet-sensitv hlpfr yourWind River proccts.

Wind River Instaler 27.7.03.01

3. Check that the checkboxes of items to uninstall are

= selected, and click the [Remove] button.
= e e e ] =

4. Click the [YES] button.

When the following screen appears, click the [Kill]
button.

@ Are you sure you want to remove the selected products?
I

W Running processes are blocking the remove operation.

™ Running processes are blocking the remove operation.

The following processes must be ended before the installer can continue:

Process ID Executable

@ 81% <install dir>¥workbench-3.2¥dfw¥host¥xB86-win32¥bin¥dfwserver.exe

8 160 <install dir>¥workbench-3.2%wrwb¥platform¥x86-win32¥eclipse¥eclipse-xB6-win3Z.exe
@ e <install dir>¥jre¥1.5.0_11¥x86-win32¥bin¥javaw.exe

==

284

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

5. cClick the [Finish] button.

Completed

uoneelsuIun Z°9
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6.2.3 After uninstallation

After uninstalling CW Workbench, some folders and files remain in the installation folder.

(1) Data not to be deleted
The remaining files and files are left to speed up the start-up of the installer when the product is installed again.
There is no problem even if the remaining folders and files are directly deleted from Explorer if they are not

necessary.

+ Data not to be deleted
Some files including Workspace folders and image files in <Folder of the installation location>.

After uninstallation, a deletion error dialog box shown below may appear when a folder of the installation location is deleted.

Click the ak. | button. Restart the development environment (personal computer) and delete the folder of the
installation location again.

Error Deleting File or Folder

@ Cannat delete ibwpwr41: Access is denied.

Make sure the disk is nat full or write-protected
and that the file is nok currently in use,
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

6.3 Update

This section explains how to install the updated license product (SW1DND-CWWLQ24-EVZ), how to operate, and
precautions.

6.3.1 How to update CW Workbench

Start installing CW Workbench Insert the CW Workbench (SW1DND-CWWLQ12-E)
DVD-ROM into the DVD drive to start the installer.

1. After the installer is started, execute one of the

“w Extract Installer

following operations, and click the [OK] button:

Wind Ri ds inztalling diff d includi iohs in thei fiold . . .
1o void any il e versioning soues. 11y have  spociis siaton Whero you + Enter a folder name of the installation location.
need to install multiple products [or versionz] in the same location, please contact Support .
for additional guidarice as some versions and products are designed to be installed in the * Click the [Browse] button to select a folder of
zame location. Select the install location:
Brome the installation location from the tree view.
Ok | Cancel |

Point/’

@ The following characters can be used for a folder name of the installation location:
» Alphanumeric characters (space cannot be used.)
* Hyphen "-"
* Underscore "'
The product cannot be properly installed if characters other than those described above are used for a folder name.

284

slepdn €9

2. Click the [Next] button.

Wind River Instaler

Wind River Workbench 3.2 for Mitsubishi C Controlers

JOUSGIOM MD o1epdn 0} MOH L'€'9

WIND"

Wind River Instaler 27.7.03.01
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3. Click the [Next] button.

Choose online updste settings:

[ Check forand apply insallerupdtes (instale restarts  necessan)

) Check onlinefor the laest Wind iver product updates.

» Network Settings

WIND"

Point/’

When the personal computer is connected to the Internet via a proxy server, click "Network Settings" and select the
checkbox of "Connect to the Internet using a proxy server", and configure the proxy server set for the Internet connection.
In addition, the Internet connection status can be checked by clicking the [Test Internet connection] button.

Choose online update settings:

O Check forand
] Check onlinefor the ltest Wind River product updates
~ Network Settings
Test Internet connection
[ Enable paralel download up to 4 HTTP connections.
A Connect to the Internet using a proxy server

rver type: @ Web Proxy O SOCKS Proxy.

] port: [

WIND"

<

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

4. To continue the installation, select one of the following procedures:

If the permanent license file is not obtained

+ Installation using a temporary license (a personal computer can be connected to the Internet)
It is the same installation procedure as the one for temporary license using product with license.
([Z5 Page 32)
Enter the LAC (License Authorization Code) written on the License Agreement of updated license product to
LAC on the User Information window.

* Installation using an install key on the DVD-ROM (a personal computer cannot be connected to the Internet)
Note that the installation using the following install key files cannot be executed.
* Install_SH_IA.txt of SW1DND-CWWLQ24-E
* Install_SH4.txt of SW1DND-CWWLQ12-E

If the permanent license file is obtained

(1) Select "Permanent activation" and click the [Browse]

button.
VWWW‘«TT e e Select the permanent license of the product to be
i installed from the tree view. Then click the [Next] button.

[ =

O Manually enter il intallstion key=

WIND"

o o

g w w

LS

(2) To continue the installation, select one of the following g 2

procedures: 5°®
p W R * When selecting "Typical" -§
Q
Z o <> (1) [Z=" Page 48 T
o}
= Poven » When selecting "Custom" =
; = (1) [ 5 Page 49 g
g
3
>0

Help. < Back Nex Cancel
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When selecting "Typical"
(1) Click the [ ACCEPT] button.

By clicking "l ACCEPT", you consent to the terms of these agreements. If you do not wish to be bound by the terms of these agreements, click
Cancel and do not install this software.

ey Py IF YOU HAVE SIGNED A WRITTEN AGREEMENT WITH WIND ,
> Wind River License 2 RIVER FOR THE PRODUCT PROVIDED TO YOU ON THIS DISC
THE TERMS OF SUCH WRITTEN AGREEMENT WILL SOLELY
GOVERN YOUR USE OF SUCH PRODUCI. IF YOU HAVE
RECEIVED A PRODUCT WITHOUT ENTERING INTO A WRITTEN
LICENSE AGREEMENT WITH WIND RIVER SYSTEMS, YOUR USE
OF SUCH PRODUCT SHALL BE SOLELY GOVERNED BY THE
PRODUCT EVALUATION LICENSE AGREEMENT BELOW.

PRODUCT EVALUATION LICENSE AGREEMENT

THIS PRODUCT  EVALUATION ~LICENSE ~ AGREEMENT
("Agreement”) is a legal contract between Customer (*Customer”
or "you") and Wind River Systems, Inc, ("Wind River"). The right
t0 use the Product is granted only on the condition that Customer
agrees to the following terms. If Customer does not agree to the
torms of this Agreement, then Wind River and its licensors are
unwilling to license the Software to Customer and you may not
install the Product.

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE
PROTECTED BY UNITED STATES COPYRIGHT LAW AND
INTERNATIONAL TREATY. UNAUTHORIZED USE,
REPRODUCTION OR DISTRIBUTION IS SUBJECT TO CIVIL AND
‘CRIMINAL PENALTIES.

PLEASE READ THE TERMS CAREFULLY BEFORE CLICKING ON
THE "I ACCEPT" BUTTON, AS BY CLICKING ON THE " | ACCEPT"
BUTTON YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
T, UNDERSTAND IT AND AGREE TO BE BOUND BY

v

284

(2) Click the [Finish] button.

=
£
D m P——

Typical
Instalstandard features with alltarget architectures.

F

Installation successful.

Please see readme for detalsor clic Finish to ext the installr:

Help < Back Fiish Cancel

1S4

Completed
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

When selecting "Custom"
(1) Check that "Install" is selected, and click the [Next]

button.

W Installr - Instal o Download

a
Clck Help below for detail.
©nstal

O Localdownload copy media to host)

WIND"

(2) Click the [Deselect all] button.
(3) Select the following items, and click the [Next] button.
* For Q24DHCCPU-V/-VG: "Intel"

D | « For Q12DCCPU-V: "SuperH"

Terget Architectures:

WIND"

slepdn €9

(4) Check that the checkboxes of all items are selected,
and click the [Next] button.

Select Products Eshow Installed Content

640
680

H
D
i Works 68 412
2o 2010
> 2@ 3.2 for VxWorks 6.8 (Enabler Rev 3) 320
> I Wind River Workbench Core 32.03 220

JOUSGIOM MD o1epdn 0} MOH L'€'9

Installtion Directory
[2

1.3 GB (167,32 GB available)
483,64 M8 (local media)

To the next page
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(5) Select "I ACCEPT the terms of these license
agreements." and click the [Next] button.

By selecting "I ACCEPT A

> Wind River License. IF YOU HAVE SIGNED A WRITTEN AGREEMENT WITH WIND
> Wind River License 2 RIVER FOR THE PRODUCT PROVIDED TO YOU ON THIS DISC THE
TERMS OF SUCH WRITTEN AGREEMENT WILL SOLELY GOVERN

DUCT

EVALUATION LICENSE AGREEMENT BELOW.
PRODUCT EVALUATION LICENSE AGREEMENT

THIS  PROI EVALUATION  LICENSE  AGREEMENT
[Agreement) is  egal contract between Customer ("Customer- or
River’). The right to

n that Customer
- If Customer doos nn( 2gres to the
Win and its licensors are
unwiling 10 license the. "ofwere 1o Costomer and you may not
install the Product.

WIND"

THE SOFTWARE AND ACCOMPANYING DOCUMENTATION ARE
PROTECTED BY UNITED

INTZRNATIONAL TREATY: UNAUTHORIZED,USE, HEPRODUCTION
&R DISYRIBHVION IS SUBJECT TO CIVIL AND CRIMINAL

PLEASE READ THE TERMS CAREFULLY BEFORE CLICKING ON
BY CLI

THE "1 ACCEPT" BUTTON, AS
BUTTON YOU ACKNOWLEDGE. THAT YOU WAVE READ. THS
AGREEMENT, UNDERSTAND IT AND AGREE TO BE BOUND BY ITS
TERMS AND CONDITIONS.
1. DEFINITIONS. M
@1 ACCEPT the terms o these lcense agreemens
1100 NOT ACCEPT the terms of these icense agreements.
Help < Bk Next > Cancel

(6) Click the [Install] button.

H Products and Features
cick nsal.
[ Wind River Workbench 2.2 for Mitsubishi C Controlers.
> (3 VeWorks 6.41 Applicaton Developer &40
> [ WWorks 6.1 Applicaton Developer &80
> D8 Wind River GNU Compilr 1.2 for VxWorks 68 a2
08 Wind Rver Setup 201 2010
> [0 Wind Rivr Workbench 2.2 for VeWorks 68 Enable Rev 3) 220
> I8 Wind Rivr Workbench Core 3203 320
Installation Directory Shortcut Options
C¥WindRiver
Desktop shortcuts: +
Disk Space Information =
Instalation Sze 1.3 GB (1875 GB avalable) Startmenu entres: -
Download Size  483.64 MB (local media) frolies rae: Ll

[hep <Bock || sl |[ Concel

(7) Click the [Next] button.

(C]

Instaled content.

Filter products and features

H
b
M Wind River Workbench 32 for Mitsubishi C Controlers
> [ VeWorks 641 Applcaton Developer &40
> [ VeWorks 6.1 Applicaton Developer 880
> 3 Wind iver GNU Compiler.1.2 for aWorks 68 a2

0 Wind River Setup 201 2010
8 Wind River Workbench 3.2 for VWorks 68 (Enabler Rev 3) 220
> 8 Wind River Workbench Core 3203 220

G RS e

To the next page
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CHAPTER 6 INSTALLATION AND UNINSTALLATION

(8) Click the [Finish] button.

Completed

slepdn €9

USUSGHIOM MO diepdn 0} MOH 1'€'9
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6.3.2 After update

This section explains an icon registration, sample programs, and a patch application after the product is installed with
the updated license product (SW1DND-CWWLQ24-EVZ).

(1) How to start CW Workbench
After CW Workbench is installed, "Wind River" is added in the Windows Start and the following menus will be

available.
Menu Description

CW Workbench Starts CW Workbench.
Starts Wind River Registry for Workbench 3.2.

Registry,3.2 When CW Workbench is started, Wind River Registry for Workbench 3.2 also starts, except
when it is running already. An icon is registered on the task tray.

Product Maintenance Uninstalls and updates CW Workbench and applies a patch.
Starts WFTPD.

FTP Server2 For available operating systems, refer to the following section.
[ 5 Page 17, Section 2.3

ViWork a2 Starts HyperTerminal for Telnet connection.

xWorks COMx This menu cannot be used when HyperTerminal is not installed.
VxWorks Development Shell 2 Starts a command line Shell in which the GNU compiler can be used.

*1: When installing this product on the environment where CW Workbench 3.3 is installed, the menu name is changed to
'Productmaintenance~0'".
To judge a target product, select "About This Installation" of Product Maintenance and check "Installed Content".
For CW Workbench 3.2 (this product) or CW Workbench 3.3, the target product is displayed as follows:
-CW Workbench 3.2: Wind River Workbench 3.2 for Mitsubishi C Controllers
-CW Workbench 3.3: Wind River Workbench 3.3 for Mitsubishi C Controllers
*2: The names of the menus are changed depending on the version of VxWorks.

VxWorks 6.4 VxWorks 6.8
FTP Server,6.4 FTP Server,6.8
VxWorks COMx,6.4 VxWorks COMx,6.8
VxWorks Development Shell,6.4 VxWorks Development Shell,6.8
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CHAPTER 7 APPLYING PATCH

CHAPTER 7 APPLYING PATCH

This section explains how to apply a patch in case it is released in the future.

Point/

® Log on as a user with the Administrator attribute when applying a patch to the product on the development environment
(personal computer).

@® Terminate the product before applying a patch.

Apply a patch in [Product Maintenance].

® Do not stop the processing during patch application.
Apply the patch again if the processing has been stopped.

® The confirmation dialog box of User Account Control appears. Click "Allow" or [Yes] button to continue the patch
application.

7.1 How to Obtain Patch

(1) Download a patch file from the site described below.

[Z 5 Information and services
For further information and services, please consult your local Mitsubishi representative.

(2) Extract the downloaded file and store it in the updates folder in the folder of the
installation location of CW Workbench.

El When the installation location of CW Workbench is C:\WindRiver, the storage location of the patch is
C:\WindRiver\updates.

yoled UIBlqO 0} MOH |°/
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7.2 How to Apply Patch

1. start Product Maintenance from [Wind River] in
Windows Start.

2. Select "Patch".

& 5can for Product Updates and Add-ons
e et o Undaia e P o

Patch
Apply patches: individusl fies forindividual problems.

= Remove
T it v e proccs

WIND"

O About This Installation
¥ iver

License Configuration
T e e

(D}
e TS

Wind River Instaler 27.7.03.01

<

3. Check that the checkbox of a patch to be installed is
selected, and click the [Install] button.

W nstller - Apply Paches

-
=
3

C) selctpaches o

@ COR-R1Bs527.1-1 (240.18KB)

Installtion Directory Disk Space
CHWinds 2018K8/ 12029 GB

Help < Back nstall Cancel

Point/’

If the patch to be installed is not displayed, check whether the storage location of the patch file is correct.
» Patch file storage location
<Install folder>\updates

284

To the next page

54



W Instaler - Apply Patches

WIND"

€ sectpachesto st
TS

@ CORRizeszr. 11 2

Installtion Directory DiskSpace
i 240.18KB/ 12029 6B

Instaltion Proge
Patches installed successfully.

Help Back Finish

284

Completed

4. Click the [Finish] button.

CHAPTER 7 APPLYING PATCH
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CHAPTER 8 CREATING AND BUILDING USER
PROGRAM

The layout of CW Workbench is shown below.

Menu bar Toolbar

% Device Debug — UserProject/UserProject.c - GW Workbench

le Edit Sowce Relastor Mavigate Search Project Target Run Window  Help

i~ TR S R R AR RS- g - IR LR :"’I [ [ Advanced De.. [[
[ Project Explorer 57 - (% Debug Symbol Browser = O [ UserProjecte 52 = O |/ %5 Debug 33 =0
== = § #include <Vxliorks.h> ”~ =
= 2 UserPraject Gliind Fiver ViWorks 64 Dannloadable Kernel fiinelude <stdic.h> E:
By Build Tarests (SHTT50srls - debug) finclude <string.h> " "
g Wind River Launches #include <stdlib.h> & Debug
#include <taskLib.h>
¥ Binaries i
#’I Inslude #include <cickli window
[ SHTTED " . " “?nclude «ayaLib R i "
[« eyw]  "Project Explorer’ #include <time.h Editor
.| UserProf . . ’
« window #include "ObEFun window frondl =y
#include "MdFunc H w 9g Breakpoints =0
==
"Breakpoints" -
#define MAX DEV MO  {31) s BATHAAES = P
i window
< | ES gfedeha
— = 0111001
18 Remote Systems 52 =0 .
oy
& & - R “
. £ B & B[S 09=Varizble |1l Register |G Express [ [ Memory £3 . = O
=& Local =
Wind River Fegist s Build Console 52 @] Enor Log | EJ Properties =0 hd
Local Files [a R |4 B8 ¥
% Local Shells WOTKINg UIreCTory: Ui/ Users w.:uwn/.i u?.m/nnn |)11userrru]/ecuar|u:1? enuie
i make: remaving targets and objects of G/user/ WS/ wb3.2/cvm_HowTo  Lser Project SHITE0e " H " H
T VWorksfix 19216833 tiind Biver Woiliorks 64 bl it Variables" window
it [-d" Useer]ec}A:artlal ee”: rm -rf Debue: fi " . " .
N N it [1 ~d " dirname “User Pr R " roject/EntryWDTinta”™ ™ } 1 Registers" window
Remote Systems hu[ilding UserProject_pd BUlId COnSOIe oject‘//Enlrwa'l'Int 1
it [1-d " dirname * UserPr rojectsUserProject o” 1 n A "o
: d huilding‘UserPrnJectJ:a olect/UserProjecln ExpreSSIOnS WlndOW
window it [! -d “"dirname “UserPr rtla\Imageﬂ I then mhdi "™ B " wind
building UserProject p. tiall
it [V -d " ditname "JUserPro]ect/Debug/UserPro]ectout"’ "1 then mkdir -p dlrname UserPre emory rowser: window
building UserProject/Debue/UserProject.out
make: built targets of C/user/ WSk 32 cmm_HowTos User Project/SHTT80enule
Build Finished in Project ‘UserProject”  2010-08-26 09:15:06 <{Elapsed Time: l]—
4 ) B
i\ s ¢ E B : 20Mof43M ([ ©

The layout of each window can be changed by dragging with the mouse. The layout shown above is the default layout.
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

8.1 Creating Project

(1) How to create a project

1. Start CW Workbench from [Wind River] in Windows
Start.

284

Enter a folder of storage location of workspace for

@ "Workspace:".(A folder can be also selected from

the tree view by clicking the  Erowse... | button.)

Ei . .
8 Loone. | Clicking the 0K | button starts cW
MNote: The workspace directory must be writable,
and should be located on Fast (local) storage. WO rkbench

[[]use this as the default and do nok ask again

‘s Workspace Launcher

Select a workspace

oW Workbench stores your projects in a folder called a workspace,
Choose s workspace folder to use For this session.

wWorkspace:

A message box shown below may appear. Click the ]S | button.

& Warnine g|

‘ind River Registry created a new database at
1\ CiindRiver/windfwtxreed hostname'

I you have been using Wind River Warkbench before, and you want to
migrate your old target connections, please quit Workbench and the
Registry now, search for the file named 'wixregd hostname' in your ald
inztallation and copy it to the new location.

For details, see the Online Help.

[ Do not show asain

@

3. Select from the menu bar [File] => [New] => [Wind
River Workbench Project...].

yoafoid Buneasn 1'g

‘s Basic Device Development — - GW Workbench
Source  Refactor  Mavigate Search  Project  Bun Window  Help

Alt+Shift+N M gl Wind R

Open File,. i Project..

To the next page
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s New Wind River Workbench Project

Target Operating System

Select the tareet operating zyatem for the project.

4. select the following item for "Target operating

system:". Click the [

Mext button.

Tateet operating system: [Wind River Wiilforks 6.4

Wind

®

> For Q24DHCCPU-V/-VG:
"Wind River VxWorks 6.8"
=> For Q12DCCPU-V:
"Wind River VxWorks 6.4"

1S4

‘s Hew Wind River Workbench Project

Shared Uzer Library
Static Kernel Library
Static Uger Library
Idzer-Defined

Tiore:

Build Type <

Select the build type for the project. ['

Build tvpe: | Downloadable Kernel Module w
L Fe ime Processﬁpp ization

Description: |Relinkable Kernel Module

Setup information

Fesulting project type: Downloadable Kernel Module Project
Idzed build taol: Linker

@

[ <Back ﬂext>,\¥] Finish
2

58
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To the next page

5. Select "Downloadable Kernel Module" for Build

type:". Click the [

Hewt > button.




CHAPTER 8 CREATING AND BUILDING USER PROGRAM

Enter a project name for "Project name:" and click
s Hew Wind River Workbench Project

the [ Finizh button.

Project —
Create a new project with the specified data. B "UserProject" has been entered here as an example

Project name: |[I

Location
(5) Greate project in workspace
() Greate project at external location

() Create project in workspace with content at external location

Directary: |C¥WindRiver¥work space¥User Project Browze...

@ Mext > Finizh Rg [ Cancel
L

.

Point />

If characters that cannot be used or a project name that is already used are entered for "Project name:", an error text

appears on the header of the window and the [ Einizh ] button becomes disabled.
« If space is included in the "Project name:", the following error message appears.

& New Wind River Workbench Project N =
Project —
@ is an invalid character in project name 'User Froject B

Project name: []

Location
(®) Create project in workspace

(O Create project at external location

(O Create project in workspace with content at external location [o¢]
Directory: [G¥WindRiver¥markspace¥User Project Brawse. -
=
[}
)
=+
>
«Q
o
-
@ S
®
Q
~~

« If a project name that is already used is entered for "Project name:", the following error message appears.

& New Wind River Workbench Project

Project
@ * project with that name aheady exists in the workspace

Project name: []

Location
(®) Create project in workspace
(O Create project at external location

(O Create project in workspace with content at external location

Direstors: [G¥WindRiver¥workspace¥ User Praject Bromse.
@

In addition, a space entered at the end of the project name is dropped.

El "UserProject "— "UserProject”

<

To the next page
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% Basic Device Development - - GW Workbench
File Edit Source Refactor Mavieste Search N Fun Window Help
i e B its-0- 5.  Open Praject

Project References

f(\:, Project Explorer 23

Cloge Project

Open Wind River Vxiorks 64 Development Shell

% Build Al ¢
Build Project t
Clzan
Build Options

Properties

& Properties for UserProject E |E‘&‘
ftype fifter et Build Properties (S A4

. Resource
inary Parser

Specify all build properties.

@ Build Support and Specs | 4 Build Tools | $ Build Macros | C= Build Paths | = Libraries
Build support
(@ Managed build  (makefiles generated by the IDE)
© Dicabled

G+ General
- Project Info

- Projest References
* Refactaring History
- Fun/Debug Settines
- Task Tees

* Validation

Build command: (sgrokeprefix make —no-print-directony

Available and enabled build specs:
SH7750znule

Enable All

Default build spec: [SHTTE08nule ¥

Active build spec: | SHT750enule v

H—,g-enug mode

Restore Defaults Apply
@

8.

On the "Project Explorer" window, select a project
where properties should be set. With the project

selected, select from the menu bar [Project] =>
[Properties].

Select [Build Properties] from the tree view to the
left on the window, and click the <<Build Support
and Specs>> tab. Check that the following item has
been selected for "Available and enable build
specs:".

2> For Q24DHCCPU-V/-VG:
"PENTIUM4gnu"

=> For Q12DCCPU-V:
"SH7750gnule"

Point/’

® When the project has been imported, unsupported build specifications may be displayed for "Available and enable build

specs:".

Since this product supports only the following build specifications, clear the check boxes other than the following build

specifications.
=> Q24DHCCPU-V/-VG: "PENTIUM4gnu"
=> Q12DCCPU-V: "SH7750gnule"

@ The default is in the debug mode. Clear the "Debug mode" check box during operation.

1S4

% Praperties for UserProject - B

fovpe fiter text Build Properties o -
Res
Resource Specify all build properties.

| @ Build Support and Specs | o Build Tools | $ Build Macras | £ Build Paths [ Libraries
| Ee)

Note: Leave this field blank to store build autput toesther with the sources, or enter an abselite
path {environment variables are permissible) to redirect the output

Build spec specific settings

]

GG+ General

- Projeot Info

- Project References
Refactaring History

- Fun/Debug Ssttings
Task Tags

Redirection rast directory: |

Active build spec: | SHT7508nule >
Validstion
Redirection directory: [SHT7E0gnule |
& Includs path:
Tnolude directories Generate
~IS0NIND BASE)Asreet/h [ e
-IS0WIND B ASE) Arareet/h/wrn/coreip Iy

Add to all

Remave,

Remove from all.

2lle
£||5

Restore Defouls

GCancel

@

1S4

To the next page

9. select "Build Properties” from the tree on the left of

the window.
Open the <<Build Paths>> tab and click the

| Add.

button.




CHAPTER 8 CREATING AND BUILDING USER PROGRAM

: 10. Click the button.
% Add include search path to selected build spec E| Browse..

11. Select the include folder on the "Select directory”
Select directory window

Click the k. | button.

= I MELSES A
= I CoPu
) cCIEC =
[ CoLmg
[ coPuTOOL

= ) D
= iclude |
7= Trnle :
3 | 3
Folder: |1“C|UCIE |
[ Make Mew Folder l [ o3 ] [ Cancel l

The include folders differ depending on the C Controller module or Setting/monitoring tools for the C Controller module to be ©

used. For details, refer to the following table. ;

¢ Controll dul Setting/monitoring tools for I g

ontroller module nclude folder =

the C Controller module a

o

Q24DHCCPU-V S.

C:\MELSEC\CCPU4\Q24DHCCPU-WInclude 2

Q24DHCCPU-VG SW4PVC-CCPU -
Q12DCCPU-V (Extended mode) C:\MELSEC\CCPU4\Q12DCCPU-WInclude

Q12DCCPU-V (Basic mode) SW3PVC-CCPU C:\MELSEC\CCPU\DVx\Include

*1 When Setting/monitoring tools for the C Controller module is installed in "C:\MELSEC".

<
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12. Check that the folder specified on the "Select

W Add include search path to selected build spec

directory" window has been selected.

gl Click the Ok | button.
|—IO:fMELSEOiCOPUfDfoInc ude

I_ Erowse... H OK E[ Cancel
2 S

T T—— 13. Check that the include path of MELSEC added to

Bulld Properties G- "Include directories" in [Include paths:] appears.
- Resource

Specify all build properties.

Binary Parser

- Build Properties Build Support and 5 Build Toals | $ Build M (= Build Paths | = Lib i
i | @ Build Support and Specs | o Build Tools || $ Build Macros | ibraries Click the Ok button.

O/G++ General Redirection root directory: | ]

- Praject Info

Froject References Note: Leave this field blank to store build output togsther with the sources, o enter an absolute

- Retactering Histary path (enviranment variables are permissibled to redirect the output,
. Run/Detug Settings Build spec spenific ssttines
- Task Taes Active build spec: | SHI7E0enule ¥

Walidation

Redirection diectory: [SHT50emule | [Default

& Telude paths:

Tncludz directaries Gienerate...

~IpWIND_BASE) targst/h
~IHOWIND_BASE) target hiwrn/corein

|

Restore Defaults
@

Point/’

Click the ]S | button. If the following message box appears, click the |

A C/C++ Index configuration changed

92 The C/C++ index needs ta be rebuilt ta reflect the build property
\l) changes you just made.
D you wish to rebuild the indes: now?

[rememnber my decision

<
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

74. on the "Project Explorer” window, right-click a

Eile Edit Sowce FRefactor Navieate Search Projest Bun Window Help project where a file is added. Select from the pop-up

iflmd G PB-O- g EE el
menu [New] => [File].

[ Project Explorer i3
£

=4 Project

L‘rﬁ Build Tareet

2 Copy Ctrke [5 OTD
[ Paste Cirbey K File
3 Delete Delete 4 File from Templat

Point/

Various files can be added to the project using the new file addition function ([File] = "New" => "File") or "Refresh".
However, note the following before adding files to the project:

® Do not add projects with the same name as the project name.

@ If a file with the same name as the project name exists in the project, do not use the "Rename" function of CW

Workbench for the file.
» Delete the file from the project if possible. (Note that the file is also deleted from the hard disk.)

« Change the file name on the Explorer if the file cannot be deleted. After changing the file name on the Explorer,

execute "Refresh" in the pop-up menu of the project.
« If a file name is the same as a project name and is changed using "Rename" of CW Workbench, the build

cannot be executed.

15. Enter a file name of a source file for "File name:".

% New File
File Clickthe | Finish button.
Create anew fil resource, "Sample.c" has been entered here as an example.

Enter or select the parent folder:

| |zerProject |

1= RemoteSystemzTempFiles
[;_—,C- |JzerProject MWind River WeWarks 64 Downloadable Kernel Madule Praj

joafoid Bunesasn |'g

< | =

File name: |

Bdvanced »>

@ [ Einish%[ Cancel
<~

To the next page
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Point /S’

+ Enter a file name with extension (.c, .h, .cpp, .hpp) for "File name:"

» Do not use two-byte characters for a file name. Do not execute the compile for a file that has a name including

two-byte characters, or a compile error occurs.

« If characters that cannot be used or a project name that is already used are entered for "File name:", an error

text appears on the header of the window and the [ Einizh ] button becomes disabled.
File
@ 7 ig an invalid character in resource name ‘Samp7lec _I

Erter or select the parent folder:

|UserProject ]

I}
T3 RemoteSystemsTempFiles
125 UserProject (Wind River Wiaharks 6.4 Downloadable Kemel Madule Proj

[ | =
File name: [Samp7lec ]
Advanced ¥

©

16. Edit the source files on the "Editor” window and

Fle Edt Source Refactor Mavigate Search Project

<

Run Window  Help

include the following include files:

- Buld Targets (SH77s0gnule)

&G Includes
(= SH77S0gnule
(= UserProject
(= UserPraject_partislimage
L5 Makefil
(2] Sample.c

64

Br-Ee i -0 F (Mal ¥y -t [}

[ Project Explorer 52 = [ [<) sample.c £3

| E[G)/# @ - ¥ || #include "GofFunc.n”  /+ Bus interface funcrion header %/ > For Q24DHCCPU_V/—VG
2 @ LoarPraact (wind Fver Usiworks .4 Donmiosdatia || | #Himelude MHAFune.ne /* MELSEC data link function header +/

+ Bus interface function: "QbfFunc.h"
* MELSEC data link function: "Mdfunc.h"
» C Controller module dedicated function:
"CcpuFunc.h"
> For Q12DCCPU-V
» Bus interface function: "QbfFunc.h"
» MELSEC data link function: "Mdfunc.h"

284

Completed



CHAPTER 8 CREATING AND BUILDING USER PROGRAM

(2) Adding source file

Follow the instructions below to add a source file that has been already created to the project.

1. Copy the created source file to the current folder of

a project to be added.

[Ex]

Copy EntryWDTInt.c to the current folder of the
project to be added (UserProject) on the Explorer.

Select the project to be added on the "Project
Explorer” window. Select "Refresh" in the pop-up
menu.

Gio Into

B Ciopey Crl+0
[ Paste Citr [+
e Delete Delete
Rename F2
Mo,
Attributes 3

Fug Impart..
£ Export..

Open Wind River Widhiorks 64 Development Shell
**# Build Project Cir[+5hift+d
& Rebuild Project

Build Options 3

3. Thefile "EntryWDTInt.c" copied in the step 1 has

zerPro nd River \ 6. L aject]
E Euild Tareets (SH7750=nuled been added to the project.
----- i Wind River Launches
El--qg-:' Binaries
i UserProject partiallmage.o - [sh/le] (SH7750enule)
-- UzerProject partiallmage.o - [sh/le] (SH7750enule — debug)
UserProjectout — [shile] (SHTTE0=rule)

joafoid Bunesasn |'g

UserProjectout — [zhdle] (SHTTE0znule - debug?
E]---@]] Ihcludes

= SHI7E0enule

Completed
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8.2 Adding Project

In CW Workbench, multiple projects can be managed on the same workspace by adding other projects following the
instructions below.

El Adding a C Controller module sample project (EntryWDTInt)

1. Right-click on the "Project Explorer" window and
s Bazic Device Development — UserProject/Sampl
select "Import...".

File Edit Source BRefactor Mavigate Search  Project

I O-HE @0 4 dE

E‘i—,PrDject Explurer e <}=='é> »@-> =0
. H}ﬂj Elmld Targets {SH??EDEHME} Hew
------ -5 Wind River Launches Go Into
. |j] Ihcludes .
= G
...... @ Samplec G| 2oy
EE Paste
¥ Delete
Rename
Miove...
Attributes
B Expgrt...g

<

s Import

2. Select "General" <> "Existing Projects into

Workspace".
Select

Create new projects from an archive file or directory. \A

=] Clickthe | Mext > button.

Select an import source:

|type filter text

== General
----- [E Archive File
..... @@ Build Settines

[El Oomblned Workspace Import

{:l File System

----- ﬁ) Perzpectives

----- E Preferences

#i Wind River Target Gonmections

----- B Wind River Workbench Breakpoints
[ AT+
EJ'"E oS
[H-2= Desktop
= Remote Systems
@ Fun/Debug
[Eb Team

Eb Wiarks Bx

®

To the next page




CHAPTER 8 CREATING AND BUILDING USER PROGRAM

3. Sselect "Select root directory:" radio button and click

s Import _ _
Import Projects _ ‘ the  Browse.. | button.

Select a directory to search for existing Eclipse projects.

(%) Select root directory: | Browsze..

I

() Select archive file: | Browze..

Projects:

Select All
Degelect All

Refrezh

i

[ Copy projects into workspace
Wark ing sets
[ 4dd project to warking sets

Working sets: Select..

@

— 4. Select the folder where the project to be imported is
Browse For Folder f .
——= stored and click the Q. | button.

Select rook directory of the projects to impork

[e¢]

Y

>

oy

) SntpTimeSet 4| 3

= ) QBFtest o
I CFChange %‘

IC3) MationLink,
I QEFMessage

I3 Script
I v |
& JilF ] |
Folder: | EREryWDTInE |
[ Make Mew Folder ] L CE ] [ Cancel ]

<

To the next page
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Import Projects
Select a directory to search for existing Eclipse projects. @

-

(&) Select roat directory: | CGIMELSECAGGPLAGCPUTOOL\Sample i 0| [ Browse.. |

() Select archive file: | |

Browze..
Projects:

----- EntryWDTInt {0\ MELSECCOGPUNCGPUTOOLSampled DV:AC) [ Select all
< >
[ Copy projects into workspace
Working sets

[ Add project to warking sets
iarkine sets: Select..
@ Mext = Finizh ] [ Cancel

68

Point/’

5. Alist of the projects stored in the folder (including

subfolders) specified in "Select root directory:" is
displayed in "Projects:". Check that the project to
be imported has been selected.

Click the [

Einizh button.

When a project created in Wind River Workbench 2.6.1 is imported, the following message appears.

Click the |

button.

% Project Mieration
%)
.

Carreert now?

Exizting project description files in this workspace have to be converted
to the new Workbench format. If these files are not converted, some

functionality may be compromized, Converting projects may make theze
incompatible with older Workbench verzions.

X

[ s ’ Mo ]

The following warning message appears on the header of the window when there is no project that can be imported in the

specified folder.

Import Projects
& Mo projects are found to impart

284
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6. The specified "EntryWDTInt" project has been

imported to the workspace.

A% Basic Device Development — CW Workbench
File Edit Source PRefactor Mavieate Search  Project  Bun

i i T - A R R =
I}_-, Praject Explorer 3 =0
HE e

Ertry WD TInt Divind River 4 Dovenloadable
B&H UserProject Giind River WoWorks 6.4 Downloadable |
+ mﬁ] Build Targetz (SH7750enule - debug)

iy Wind River Launches

--ﬁ' Binaries

|@] Includes

#-(Z= SHT780enule

1S4

Completed

108fo.d Buippy Z'8
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8.3  How to Build Project

Follow the instructions below for how to build the project.

1.

s Basic Device Development — UserProject/Sample.c - GW Workbench

File  Edit Source Refactor Mavigate Search  Project Bun Window  Help

HOO-H G E 0 dE TR e

§ Getting Started (] Sam

B Copy Cirl
EI Paste Citrl
¥ Delete Diele
Rename F2
Move
Attributes
f2g Import..
£3 Export..

Cpen Wind River WxWorks 6.4 Development Shell
% Build Project Citrl
& Rebuild Project

Build Options

Ciloge Project g

2.

\s Basic Device Development — UserProject/Sample.c - GW Worl

File  Edit Source Refactor Mawvieate Search  Project Bun Window  F

F\ﬁfj*n @ﬁ'u'ﬂjv d B m § % i

roject Explorer = = = etting Stal
[ Project Explorer £7 (== ¥ =0 Gietting 5
[
Mew
(@ Wind River || G0 Into
@] Ihchudes
h =
: =] Ciop Cirl
B Samplec
@ P (B Paste Citr|
K Delete Deh
Fename F2
Mo
Attributes
£y [mport..
£y Expart..
Cpen Wind River ViWorks 64 Development Shell
** Build Project Cirl
Build Options k

284
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On the "Project Explorer" window, right-click on a

project name to be built. In the menu that pops up,
select [Refresh].

On the "Project Explorer" window, right-click on a
project name to be built. In the menu that pops up,
select [Rebuild Project].



CHAPTER 8 CREATING AND BUILDING USER PROGRAM

rs—(. 3. Ifthe message shown to the left appears, click the

4 Build |
: . i i{ button.
3 You may need to set the include search path for 'UserProject’ If the L Ciontinue J
\1 ) included files are unambiguous and visible in the workspace, vou can
generate the path now and the build will procesd i
To manually =et the projects build properties, cancel the build. To
proceed without generating the include search path, click Continue.
[Generate Includes...] [ Cancel ] | Continue |~
. . . I
e B S ale SO i% AEE 0 4. The build process is displayed on the "Build
;Cv;k D"m".; no-print-s r;r}-mrykBLIILDIEPE(;:SHTI?gﬁm!IIe DEE{LIG)!ODE:H TRACE=1 clean all a .
Harkin Direstor. O indilor otk psce Ueerb ol Sl el e Console" window.
if [ -d “UserProject” I: then cd “UserProject”: rm —rf NonDebug: fi
1 frd b vaAect)ljam;\ln’\ag‘e" I then cd"Useg’rglzﬂ/‘ojﬁm‘a\lmage" et i L D s Frooct sl Yon Db Otscte/Lsr
e S T S R0 iy hrme Lol Mo s rof et Build Finished..." is displayed after the build is
E‘I mar;e _User,P"ayell:;/{;lnnEEUbug/\ﬁlse_eryed au(""'] then mkdir -p ™ dirname " UserProject/NonDebue/UserProjectout” ™" fiecho " buildine User Project,/NonDeb. . . .
gt 7 e B s et/ SHTT Dl completed. Check for error indication (red) on the
ished in Project UserProject™ 2010-10-30 14:50:27 (Elapsed :

[l

"Build Console" window.

Point/’

@ |If the following error "command not found" occurs for the build result, an unsupported compiler may have been used.
Check that only the following build specification has been selected for the <<Build Support and Specs>> tab in [Build
Properties] of the project. If check boxes of build specifications other than the following have been selected, clear them.

(= Page 57, Section 8.1)
> Q24DHCCPU-V/-VG: "PENTIUM4gnu"
> Q12DCCPU-V: "SH7750gnule"

B8 Build Gonsole 52 Sl Feds @) 9] Ervor Log | B Gonsale =0
S-=8l 2 # Lo E | ZEE”
building UserProject/Debue/0bjects/UserProject/Sample o : ~

CHDOCUME™ PS32965NLOC ALS ™1 Tempimake1 4208 sh: doc: command not found
@CHWIOP_Bonork =6 84 hosty 36w in32 himtmak e exe: #44 [Ussr Project/Debue /Objectsd User Project /S
Build Failed in Project 'UserProject’ (Process Exit Walue was 2):  2010-07-29 131801 —
w

@ |If the build result has an error, error information (source file name, line number, and error details) is displayed in red.
Correct source codes in the error part.
Execute the build again after correction. Repeatedly correct and build the source codes until the build result is not
colored red.

E8 Build Console 52 @] Error Log | = Froperties =0

s-elal 0 wiag 2FHE "

WOTKINE DITECTOry. U7 USers_Wo/ W52/ CHW_HOW 107 USETFIOJect7 o/ ToUEnuTe
make: remaving targets and objects of Guserd WSAnb3 2/ o HowTo/ User Praject/SHTE0enule
if [-d “UserProject” I then cd " UserProject”; rm —rf Debue; fi
if [-d "UserProiecpartia\Image"’ 1 then cd " UserProject partiallmagze™; rm -rf Debug; fi
if [! -d ""dimame “UserFroject partiallmaee/Debue/Objects/ UserProject/Sampleo”™ " 1 then mkdir -p *"dimame ”
building UsaeriectertiaIlmagelDehug/Ohiecls/UserPmiecl/Sample,n
Crfuser WS mb3.2/omw_HowTo UserProject/Sample.c: In function *UserProjsct

@0 user S ABE 2/ o How o User Project/Sample.c0%: ervar: stray ¥129' in program

@G uzer WS /b3 2/ own_HowTo/ User Project/Sample.c:99! stray '@ in program

RN aorks—F S hos yB-windZy hinmake exe: V6 [serProject partiallmagze/Debue /OhjectsUserProje
Build Failed in Project 'UserProject’ (Process Exit Value was 2} 2010-08-26 10:28:33 (EIapset:

13

< | ¥

Double-clicking the error line where a source file name and a line number are displayed jumps to the error location of
the source file.

<
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71

19loid pIiNg 0} MOH £°8




5. After the build is completed, execution file (user
& MonDebug

Fle Edt View Fovorites Took Help = aw program) to be used on the C Controller module is

eBack @ J Lﬁ pSearch = Folders v created'
address |23 ChwindRiveriworkspaceiUserProject) SH7 7S0gnulelUserProjectiMonDebug V| Go If an error occurs durlng the bu"d’ a user pr°gram

Size | Type is not created.
File and Folder Tasks 1KB  Tornado
N KB OFie A file name of the user program is "<Project
=]} Reename this fil 1KB OUT File

@ Move this file
Copy this Fle

name.out>".

wv|< 1] >

Folders where a user program is created:

® In Debug Mode:
> For Q24DHCCPU-V/-VG:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\Debug
o> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\Debug

® In Release Mode:
> For Q24DHCCPU-V/-VG:
<Workspace folder>\<Project name folder>\PENTIUM4gnu\<Project name folder>\NonDebug
o> For Q12DCCPU-V:
<Workspace folder>\<Project name folder>\SH7750gnule\<Project name folder>\NonDebug

When a user program is created on a project imported, the folders above change depending on structures of folders and
projects where the imported project exists.
Check the folders where a user program is created on the imported project.

1S4

Completed
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CHAPTER 8 CREATING AND BUILDING USER PROGRAM

Setting Optimization Option

This section explains how to set an optimization option that prioritizes the processing speed.

4 Basic Device Development — UserProject/Sample.c — GW Workbench
Eile Edit Source Refactor Mavieate Search [E Bun  Window Help

ATl i alE lavy

i& By R Cipen Project

Project References

R:, Project Explorer &2

& Properties for UserProject f

[tupe filter text

o Build Targets (SH77E0gnule)
i Wind River Launches |gap Build All 1

B e
E 5 o Giloge Project

Qpen Wind River WiWorks 64 Development Shell

Build Project !

Clean..

Build Options

T —
2\

Build Properties

= 2-

Resaurce
. Binary Parser

Builders

G/C++ General

-

Project Info

Froject References
:..Relactnrmg History

Fun/Debiue Settines

Task Taes
*Validation

Specify all build properties:

@ Build Support and Specs | & Bujld Tools | $ Build Macras | (= Build Paths || = Liraries

Suffives: [te

Build output eeneration
(&) Generated build output is an object
© Generated build output is a build tarzet

Build tareet can be passed

Build spec specific seftings

Active build spec: [SHT7508nule v
Derived suffic [¥o ]
Command: & [echo “building 8" Kecampilerprefidd $TOOL PATHIesh K -

DebugMadeFlagsk $ToolFlags% $ADDED GFLAGS) Sncludest E]
$CADDED INGLUDES) -DGPU=HICPL) - =
DTOOL_FAMILY=F{TOO0L_F AMILY? -DTOOL=${TOOL) -D_WRS_KERNEL %

$(CC_ARGH_SPEC) —ansi -Wall -MD -MP

Tool Flags. 7

Debug mode flags
Debug mode. | & |2 |
Non Debug mode..| & [-02 —fno-bwittin ]

Restore Defaults Anply

<

To the next page

Select a project where the optimization option is

set. Select from the menu bar [Project] =>
[Properties].

Select [Build Properties] from the tree view to the

left on the window.
Click the <<Build Tools>> tab.
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3. Select "C-Compiler" for "Build tool:".
Build Properties - .
i From Click the Tool Flags.. button.

Resource
" Binary Parser Specify all build properties.

- Build Prapertizs @ Build Support and Specs | £ Build Tooks | § Build Macros | (= Build Paths | B4 Libraries|
Builders

- DAC++ General Build toak [C-Compiler
- Project Info

aperties for UserProject

[ Gopy. | [Dekete. ]

- Project References e Corpler
Refactoring History Suffises: | Linker ]
[ Partial Image Linker
‘ Build outp|Librarian
Task Toss P sz mbler
Valdation f T O

O Generated build output is a build target
Build target can be passed

Build spec specific settings

Active build spec: |5HTT508rLIe v
Derived suffix [¥o ]
Command: & [echo “building §@" Kccompilerprefixk $TOOL PATHIcesh % |

DebuzadzF laesk KToalF lazs% ${ADDED GFLAGS! KMhcludesk i
$(ADDED INCLUDES) ~DCPU=$GPU) - =
DTOOL_FAMILY=F{TOOL_FAMILY) ~-DTOOL=$(TOOL! -D_WRS_KERNEL ~|

Tool Flags. # |BGG_ARCHSPEC) -ansi -Wall =MD -MP

Debug mode flags
Debug mode.. | & 2 |
Mon Debug mode..| & [-02 —fno-builtin ]

Restore Defaults
@

Select "C++-Compiler" for C++.

284

4. Onthe "Optimization" dialog box, select [Enable

% Gnu Compiler Options

i maximum speed optimizations]. Check that "-02"

Selected option:

Optimization " H " H
Deuecine b : has been added to "Selected option:" and click the
& Gempilation iy $(0C_ARGH_SPEC)

Cutput & [JEnable standard speed optimizations: it

. ?;:S: 7| [FIEnable maximum speed optimizations e Ok, | button.
Inteeral & [JEmphasize space reduction over speed requkes one of the above) o

Dizgnostics

' Lint Optimized cods genaration

& Tnline functions with less than: nodes
& Maximum size of & loop for unrolling: nodes

& [ Loop strength reduction and elimination of iteration variables:

# [Combine an instruction that copies one register inta ancther

# []Generate position-independent code

& [Reorder instructions to eliminate execution stalls

& [JDon't keep the frame pointer in & register for functions that don't need one

@ Stack

(@ Accumulate arguments on the stack for several function calls and pop them all at once

O Fap the areuments te each function call s soon as that function retums

# Unrall loops
(T number of iterations can be determined at compile time or upon entry to the loop
O Alnays
© Mever

Point/’

To cancel the optimization option, click &+ | in "Enable Optimization" on "Optimization" and change the mark to

v (cancel). Check that "-O*" has been deleted from "Selected option:".

1S4
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& Properties for UserProject

[tvpe filter text

Resource
Binary Parser

Builders
G+ General
Project Info
Project References
- Refactoring Histary
- Run/Debig Settings
Task Taes
Walidation

B

Build Properties -

Specify all build properties.

& Build Support and Specs | ' Build Tools | $ Build Macros | (= Build Paths | = Libraries |

Suffizes: [*o ]

Build output eeneration

(® Generated build output is an obiect

© Generated build output is a build target
Build target can be passed

Build spec specific settings

Auctive build spec: |5HTT508rule v

Derived suffic [*o ]

Cammand: & [echn “building §3" Recompilerprefizh §T00L PATHIcesh % ~
DebuzModeFlaes ¥ToolFlsesk $TADDED GFLAGE) Mncludesk -
§(ADDED INGLUDES) ~DCPU=HCPL} - =
DTOOL_FAMILY=$TOOL_F AMILY? -DTOOL=RTOOL) -D WWRS KERNEL &

Tool Flags # [$IGG_ARCH SPEC) -ansi -Wall -MD -MP

Debug mode flags

| E |
Non Debug mode..| & [-02 —fno-bwittin ]

Restore Defaults Anply

Debug mode.

e
"

1S4

Completed

CHAPTER 8 CREATING AND BUILDING USER PROGRAM

5. Check that "-02" has been added to [Tool Flags...] in

"Build Properties” and click the k. |

button.

After the k. | button is clicked, the following

message appears. Click the button.

& C/C++ Index confieuration chaneed

The G/G++ index needs to be rebuilt to reflect the build property
\) changes you just made.

Do wou wish to rebuild the index now?

1 Remember my decision

| es L?[ [ Mo
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CHAPTER 9 CONNECTING CW WORKBENCH TO
THE C CONTROLLER MODULE

9.1 Setting Target Server

The host (CW Workbench) and the target device (C Controller module) communicate through the target server (on the
CW Workbench) and the C Controller module.
Below is a setting procedure to establish communication.

Host Target device

e N 4 I

iQ Platform-compatible

Development environment C Controller module
(personal computer)

CW Workbench

( Eclipse framework )

Eclipse
C/C++ Development Tools

( Target server )

Windows

( Ethernet

76



CHAPTER 9 CONNECTING CW WORKBENCH TO THE C CONTROLLER MODULE

9.1.1 Preparing for target server setting

The following settings are required for CW Workbench to connect to the C Controller module through the target server:
+ Setting an IP address of the C Controller module
+ Setting a VxWorks image file

The files must be
the same!

Development environment (personal computer) \ C Controller module
IP address:192.168.3.1 IP address:192.168.3.3

Point/

VxWorks image files are required to be copied from C Controller module to the development environment (personal computer).

(1) How to acquire a VxWorks image file from the C Controller module

Use the FTP to copy a VxWorks image file on the C Controller module to a folder on the development
environment (personal computer).
Do not copy the VxWorks image file to a path or a folder that has two-byte characters and katakana.

A VxWorks image file of the C Controller module is stored in "/SYSTEMROM/OS_IMAGEFILE".

=> For Q24DHCCPU-V:
/SYSTEMROM/OS_IMAGEFILE/Q24DHCCPU-V_XXXXX-Y "

=> For Q24DHCCPU-VG:
/SYSTEMROM/OS_IMAGEFILE/Q24DHCCPU-VG_XXXXX-Y "

=> For Q12DCCPU-V (Extended mode):
ISYSTEMROM/OS_IMAGEFILE/Q12DCCPU-V_XXXXX-Y_ModeEX !

=> For Q12DCCPU-V (Basic mode):

/SYSTEMROM/OS_IMAGEFILE/Q12DCCPU-V_XXXXX-Y 1

*1 XXXXX: First five digits of the serial number of the C Controller module
Y: Function version of the C Controller module
For how to check serial numbers and function versions, refer to the following manual.
* For Q24DHCCPU-V/-VG and Q12DCCPU-V (Extended mode) :

MELSEC-Q C Controller Module User's Manual
* For Q12DCCPU-V (Basic mode):

[ 1 C Controller Module User's Manual (Hardware Design, Function Explanation)

Below are the default user name and password to connect CW Workbench to the C Controller module using the
FTP:

* User name: target

» Password: password
If the default user name and password have been changed, use the user name and the password acquired.
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(2) When VxWorks image files are not identical

When the VxWorks image file of the development environment (personal computer) is not identical with that of the
C Controller module, copy the image file from the C Controller module to the development environment (personal

computer). ([Z Page 77, Section 9.1.1 (1))

(3) Checking the network connection

Before setting the target server connection, use the ping command to check that the C Controller module, a
destination of the target server, is connected to the development environment (personal computer) by following
the instructions below.

1. Start the command prompt from Windows Start.

2. Execute the ping command.

Use the IP address of the C Controller module for the IP address specified for an argument in the ping
command.
The default IP address of the C Controller module is 192.168.3.3 if not changed.

3. Check that the development environment is network-connected to the C Controller module.

4. Execute the exit command to terminate the command prompt.

9.1.2 How to set target server connection

Follow the instructions below to set the target server connection.

1. Click the i button on the toolbar of "Remote

8 Remate Systems 52 . [ Kernel Objects =8
FIEe 3 T Systems".
= =
=

284
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CHAPTER 9 CONNECTING CW WORKBENCH TO THE C CONTROLLER MODULE

. 2. Select "Wind River VxWorks 6.x Target Server
°

Select Remote System Type

4

System type:

|type filter text

- (= General
[ Wihorks Bx

are;

; #@ Wind River WeWorks Gx Core Dump Connection

@

Finizh

Cancel

284

To the next page

Connection" and click the [ Mext >

button.
When both VxWorks6.4 and VxWorks6.8 are installed,
the following screen appears after clicking the

[ Mext > button.

% MNew Connection

Wind River Registry and Target Platform Selection

Please select the registry where to create the connection and/or the target
platform to associate with the connection.

Target platform: | Wind River ViWorks 6.8 ~

Create connectiq\ingd River VxWorks 6.4
e default (localhost)

Finish Cancel

® ot

Select "Target platform" and click the [Next] button.
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3. Ssetthe target connection information for "Backend

Target Server Options

& Selected proceszor will be uzed to connect to your tareet without
double—checking against real processor.

Backend settines

Backend: |wdbrpc v | Processor. [SH7780 | [ Belect. |

Target name / 1P address: 19216833 | Check.. |Port [ |

Kernel image
(O File path from target {f available!

@ File: ‘C:\MELS ECAGCPUNDWA Toolsh Gl 2DCGPLU-W_12062-B

v|| Browse., |

[ Bypass checksum comparizon

Adwanced tareet server options
[]\Werboze target server output

Options: [~R Ci/user/_WS/nb3.2/cmw_HowTo ~RiW -Bt 3 ~A v|

Gommand Line:

tetavr W -R Giusers W5/ wh3 2/ cvw_HowTa -RW -Bt 3 —c G\ MELSECAGOPIN DV Taalsh G 2DGGPL-
W 12052-B -A 19216833

@ [ <Bsok [ Mext> | [ Emish ][ GCancel |

Open File

Look ir: |@Tools V| 0 ? il e

1 1200GPU-Y 12042-F
0 5

tdy Recent
Documents

@

Desklop

@

My Docurments

e

by Camputer

File name: |mzpecPuv 120528 v [oen |

&

by Metwark, Filez of type: | i v ‘ [ Cancel ]

<

Completed

80

settings" as shown in the list below.

Connection information

Item Q24DHCCPU-V
12DCCPU-V
Q24DHCCPU-VG 2
Backend wdbrpc
Processor Z5xx SH7780

192.168.3.3(default)
(If the default IP address of the C Controller module
has been changed, set the IP address acquired.)

IP Address

Select the "File" radio button in "Kernel image" and click

the  Browse... |button.

Select the VxWorks image file and click the

button.
The VxWorks image file specified here should be the
same file as that of the C Controller module.

Acquire the VxWorks image file from C Controller
module using FTP. (_=Page 77, Section 9.1.1 (1))

Clickthe [ Finish | button to start connecting

with the C Controller module.



CHAPTER 9 CONNECTING CW WORKBENCH TO THE C CONTROLLER MODULE

9.2 Starting and connecting the target server

After setting the target server, select the added target server on the "Remote Systems" window. Connection and

disconnection can be executed for the C Controller module by clicking the "Connect"( H ) or

"Disconnect"( .;:T )button.

El Below is an example of the window when "VxWorks6x_192.168.3.3 (Wind River VxWorks 6.4)" is selected.

_Eﬁﬂemute Swstems B3 = O
£ & &1 @ B g7
E’ Local

{8

: 0 unconnected | Wind River WiWiorks 6.4

Or select the added target server with the mouse and right-click. Select "Connect" or "Disconnect" from the menu.
Under "Connect", "connected - target server running" is displayed at the bottom of the main window after the target

server is started and connected.
Under "Disconnect”, "unconnected" is displayed at the bottom of the main window after the target server is

disconnected.

_Eﬁ Remote Systems 23 = B
£ 0K &l 2 B|E7
E) Local

=% \lorks 645HTTAD [stateless] (SHT7E0
& FKernel Tazks
Feal Time Processes
S8 ECMPLoutD=5 - Svmbol file: ASYSTE
5 ECPCOoutlxd - Symbal file: ASYSTI
3 EZSocketCPPForMDoutl:d - Symbo
5 ftpdliboutl:® - Symbal file: SSYSTE

B9 @12DCCPU-Y 12062-B0x1 - Symbo %
| >

Janias 18b1e) ayy Bunosuuod pue Builels z'6

[

«  BaF

connected — tareet server running | Kernel im

Point/’

Once the target server is started, the C Controller module is automatically reconnected to the target server after the module
is normally started even if the power supply of the module is turned off and on.

To disconnect the target server, select the connected target server on the "Remote Systems" window and click the
"Disconnect" button.
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8 Remote Systems 57 = O
S e = =R - = =

E—_f Local
19216833 Gifind Riv 64

= 30
=-5gk Wind River Target Debugger MWind River Wi
=% weworks GASHTTED [statelesz] (SHTT7E0
®-@ Kernel Tasks
#-g® Real Time Processes
----- 5 ECMPLout0:E - Svmbal file: /SYSTE
----- 3 ECGPCO.outl:xd - Symbol file: ASYSTE
59 EFSocketCPPForMDout:d - Swmbo
59 ftpdlibout0:8 - Symbol file ASYSTE
50 Q1ZDCCRU-V 12082-B0x1 - Symbo %

< I »

cornected — target server running | Kernel im

The indication of the "Connect" and "Disconnect" buttons switches between enabled and disabled, depending on the status
of connection to the C Controller module.

During disconnection: "Connect"( H ) for enabled and "Disconnect"( ,;‘%T Yfor disabled

During connection: "Connect"( H ) for disabled and "Disconnect"( .I:T Yfor enabled

Point/

The following error message appears if the C Controller module is not running or if the network is not connected while the
target server is under "Connect".

% Failed to Connect to Tareet

Failed to launch tareet server for conmection "WWorks6x_192.168.3.3'
{Registry localhost)

Pozsible cause:
Back-end not connected.

Femoved dead entry from Registry!

©)

If the error shown above occurs, check the following:
» The C Controller module is powered on and is running properly.

+ The target server is connected to the C Controller module. (= Page 78, Section 9.1.1 (3))

After the target server is started and connected, select the connected target server to use the Host Shell.

For how to start the shell, refer to the following section.

[ Page 84, Section 10.2

For details on Shell, refer to the following document by selecting [Help] in the menu bar 2> [Help Contents] => "Wind River
Documentation" > "Guides" > "Host Tools" => "Wind River Workbench Host Shell User's Guide, 3.2".




CHAPTER 9 CONNECTING CW WORKBENCH TO THE C CONTROLLER MODULE

9.3 How to Check and Change Connection Settings

If the target server cannot be connected to the C Controller module, follow the instructions below to check and change
the connection setting.

1. Select the target server on the "Remote Systems"

= ¥ Disconnect "WieWarksfx_ 19216833
47 Reme and right-click to open the pop-up menu. Select
g Refresh Properties.. [Properties].
=2-E A lt+Enter
s {81

WL Duver W

% Tareet Connection @

Target Server Dptions
Feview and customize the tareet server options.

Mame |\iiorkst: 19216833 | Shared: []

fssociated target platform: |Wind River WViWorks 64 v|

Target Server Options | Object Path Mappings | Target State Refresh | Debug Cptions

Backend settings

2_ » | Backend: [wdbrpc Iv |Processor: EH??SD | [ Select... ]l(—— 3.
4 P | Tarest name / IP address:  |192168.33 v Fort: l:l

Kernel image

() File path fram tarest f availabled
5 E— —Pl@ File: |O:'\MELSEO\OOPU\ Dt Toolsh QN 2DCCPL-W 1 2052-B v| [ Bromse... ]l

[ Bypass checksum comparizon

Advanced target server optiohs
[¥]etanze tarest server output

Options: [~R G MELSEG/GWW/liork Space./CW _Workbench -RW -Bt 3 —A ~|

Command Line:

tetavr = -R G/ MELSEC/CWAN Wark Space /Gy Warkbench —Riw -Bt 3 ¢
G MELSECAGGPUY DV Toolsh N 2DCGP U= 12052-B -4 19216833

@ O H Cancel ]

sBuies uonosuuo) abuey) pue 398y 0} MOH €6

2. Check the Backend field.
Enter "wdbrpc" for "Backend".

3. Check the Processor field.
Set "Z5xx" (for Q24DHCCPU-V/-VG) or "SH7780" (for Q12DCCPU-V) for "Processor".

4. Check the IP address of the target device (C Controller module).
Set the IP address of the C Controller module for "Target name/IP address".
The default IP address is 192.168.3.3.

5. Check the Kernel image.
Set the correct VxWorks image file.((_ s Page 77, Section 9.1.1)

Do not change the "Advanced target server options" setting. (The default value is recommended.)
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CHAPTER 10How TO DEBUG PROGRAM

1 01 How to Connect CW Workbench to the C Controller
Module

« Set the target server.([_ = Page 76, Section 9.1)
- Start and connect the target server.(|_ = Page 81, Section 9.2)

10.2 Starting Shell

On the "Remote Systems" window, select the target server connected to the C Controller module where the shell is
started. In the menu that pops up by right-clicking, select [Target Tools] => [Host Shell] to start the shell.

L WU

bm UzerProj

WTH Conzole
WTH Conzale Properties
<

L=f Disconnect "Warksfix_ 19216833 Fun Debugger WTH Connection Test

H ell
Host Shell Properties

1H Remote Syst
Fefreszh Properties...
£ | &

E_? Local

=-§2l

Properties Alt+Enter

| b

i 1. Click the button.
% Start Host Shell O4xWorks6x 192.168.3 3@ meiw228) E\

(@ Please select the command line options and press OF to start
the host shell

Options:

[ it vead e Tal mitializatian fle

[ Exectrte Tel expression after intialization ()

[indicate mods to start either G[TellGdb|Cmdl.. ¢

[]Set event poll interval {msec) [default=200] (-p)

[IStartup file of shell commands to executs (-5)

Other Options:
[ J

[l Show this dialog before host shell starts

228 - Host Shell

ht : 2. Shell starts.

Completed
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10.3 Downloading Module

Follow the instructions below to download a module file on the C Controller module.
The module is used for an application, such as to download a file on the memory on the C Controller module and start

a task from the shell.

= 1. On the "Remote Systems" window, select the target
1 Remote Systems 53 =0
= g server where the module file is downloaded.
ar | &
= £ 08 B 8@k BS Select the target server connected to the C Controller
F-Ei Local

module for the target server.

L 5
S Wind River Tareet Debugger (ind River Wlorks 640
=% wiiorks BASHT7ED [stateless] (SH77E0)
H-& Kernel Tasks

a8 i Wiorks 6.

- T P U LB - T
" H 1] H
e b Lt = = £ et 2. Onthe Project Explorer" window, select the
File Edit Source Refactor Mavieate Search Project Pun  Window Help modaule file to be downloaded. In the menu that
il w0y fE TR R e e o pops up by right-clicking, select [Download
([ Project Explorer 53 5 2@ T 7O Getine St VxWorks Kernel Task].

&m Entry'WDTInt Oiind River WiWorks 6.4 Downloadable Kernel Module Project? ==
&m TestProj Oifind River WiWorks 6.4 Downloadable Kernel Module Projects
252 UserPraject Mind River Yidborks 64 Downloadable Kemel Madule Praject! . .
p.[m B Torests (SHTTS0GE) ' "UserProject.out" has been selected for the module file
s Wind River Launches
¥ Binaties
UszerProject_partiallmageo - [shle] (SHTTE0enUl)
UserPraject_partiallmage.n - [shile] (SHT7E0enule - debue)
UserPrajectout - [zhle] (SHTTENenule)
o aject.out - !
-l Icludes Mew 3
(= SHT7E0enule
e Samplec Open
Open With 3

here as an example.

5] Copy Ctrl+G
[ Paste Crl+i
¥ Delete Delete
Rename F2
Move
Attributes 3

a|npojy Buipeojumod €01

£2g [mport..
7y Export..

Cipen Wind River Wliorks 6.4 Development Shell
% Build Project Ctrl+Shift+&
2, Rebuild Praject

Build Options 3

= & | Refresh Fa

2 Bun ViWorks Kernel Task

#5. Desbue Wihiorks Kernel Task
£ Diow rhiel T

& Lacal I

284
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& Download Gonfieurations

Create, manage, and run configurations
Select the launch context for executing the launch operations.

m 3. Click the button.
@

FEx 03

Hame: [naEntryPaint - UserPrajestaut - VixWarks6s 19218833

fipe fier text
& G wdliorks Kerne| Task
G noEntryPaint - UserPrajec

18 Launch Gontext &) Donniloads | ## Projects to Build | £ Gommon|

VxWorks Kernel Task Download Options

Launch Cantext

» Advanced

@ J a2 Aaply. Revert
Filter matched 2 of 2 items.
®

86
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Completed

The module file "UserProject.out" selected in the step 2
has been downloaded on the C Controller module,
which is a destination of the target server selected in the
step 1.

The following window appears on and after the second
operation.
Select "Launch the selected launch configuration" and

click the Ok | button.

% Launch Configuration Selection

Choose Action

() Workbench has found one or mare existing launch
configurations that match your zelection. What do you want to
do?

() Launch the selected launch configuration
) Edit the selected launch configuration
() Edit a duplicate of the selected launch configuration

() Create a new launch configuration

Matching "Wiiorks Kernel Tazk' Launch Configurations:
nokl nt — roject.out

See Target Manasement/Launch Confieurations for additional settines.

® [ O ][ Gancel ]




10.4 Howto Debug Program

CHAPTER 10 HOW TO DEBUG PROGRAM

This section explains how to debug a program by using a sample program (EntryWDTInt.c) of the C Controller module

as an example.

(1) Note:

The executing module needs to be built in "Debug Mode" when a project is debugged on CW Workbench.

WDT main processing Task start

Y output task
Task name: SmpTask_2

v

EntryWDTMain()

10.4.1 Debugging one task

Function name: YWord_WriteRtnTask()

1S4

1
% Device Debug — UserProject/Sample.c — CW Workbenc

File Edit Source BRefactor Mavieate Search  Project  Target
B iflwile w8 - 0-Q B
fﬁ;, Project Explorer (7 % Debue

[

B

Debug Az 3
Debueg Configurationz...
Creanize Favorites..

AN E e WD TInt (ifind River
= IDH UserProject Miind River WWidr ;
g Build Tareets (SH7750enule - debue)
iz Wind River Launches

w4 Binarias

To the next page

Connect the C Controller module to CW Workbench.

For details,(_ 5 Page 76, Section 9.1,Page 81,
Section 9.2).

On the "Project Explorer” window, select a project

to be debugged. Click the ¥ mark on the right side
of a debug icon( iﬁ; ) on the toolbar and select

[Debug Configurations...] from the pop-up menu.
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2. Double-click "VxWorks Kernel Task" to create a new
% Debue Gonfieurations debug configuration.

Create, manage, and run configurations

[ - H. . .
LT 5 & S Configure launch sett

|t3-'|:|e filter tewt | |_<|}' - Prezz the 'Hew

-& @ttach Target Context |:=| - Press the 'Dupl
----- [ ] G/AC++ Application

----- (] C/G++ fittach to Applicati | #6 — Press the ‘Dele
----- [c] C/C++ Postmortem Debug
----- [t ] G/T++ Remote Applicatior
..... «’// Laurch Control - Edit or wiem an
-y I T.

% Waorks Feal Time Proce:

-l e
v — Press the Filte

Configure launch pers

284

3. Check that the target server connected to the C

Create, manage, and run configurations

© Pleses entr of sskat o Enty Pt ﬁ\ Controller module to be debugged has been

AIER] e Name: [noEntryPoint - TestProjout - VxWorksfix 19216833 ] seIeCted' CIICk the BTDWSE... | bUtton'
[tvpe filter text

(98 Launch Gontext - [) Downloads | % Projects to Build| & Source | = Gamman|

3 Attach Target Context

~[c] G/Cr+ Application Vxworks Kernel Task Options
G/G++ fttach to Applical
[£] G/G++ Postmartem Debu Launch Gantext: £l B8
[£] G/G++ Remote Applicatic
% Launch Control = [ @ detault (localhost!
5 Gy Vilieks Kernel Task - [A178 Vslorks6x 19216883 Gind River Vililorks 6.41

noEntry Paint — TestP)
O Vilorks Rizal Time Froct

~ General

Entry Point: 9] | [ Browse_ |

Areuments: | ]

» Advanced
~ Debug

Break on Entry
[ Automatically attach spawned Kemel Tasks

< | 2 Apply =
Filter matched © of © items
@

284
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CHAPTER 10 HOW TO DEBUG PROGRAM

4. select the function (Entry Point) where debugging
% Entry Points &l

Select Entry Point a8 starts. Click the (] | button.

@ Pleaze zelect an entry point

Fattern 7 = any character, ¥ = any string, < = end of pattern)
Module entry points:

= = Downloads
=B Entry'WDTIntout

L StatusOheckF{tn
& WA START TEXT
& WDThtHook Rin
& Yiiord White RinTaszk

[ Ok ] ’ Cancel

5 Check that the function name selected in the step 4

Create, manage, and run configurations @ has been selected for “Entry Point:"

Select the launch context for executine the launch operations.

Break on Entry
[lgiismatically aitach Spavined Kamel Taskst

B =, f
BRECR. B Mame: [EntryWOThiain - Eniry WOTIntout - ViWorkeg2 19218833 ] cllck the erug button'
fope fifter text =
beierer ] R et B Dorlosds| *% Projects to Buld | B Sowrce| £ Commen | o
3 Attach Tareet Context oo
-[£] ©/0++ Application WxWorks Kernel Task Options ~
[E] C/Co+ Attach to Application A~ b
-[E] G#O*+ Postmortem Debugser Launch Context £inraal® .
= [7] @ defoult (iocahast! g
(148 Vodorks6x 192168.33 ind River VicWerks 64) (? 2
Ent
O =
"G Vidiorks Real Time Pro: & O
«Q
g0
Entry Point: |[EntryWDTMain ] 8 o
c
Areuments | | o @
» Advanced 35 T
O =
e g &
n =
x %

4 —
Filter matched 9 of 9 items.
)

Point/’

To debug a task created (taskSpawn) from the function specified in "Entry Point:", "Automatically attach spawned Kernel
Tasks" at the bottom middle of the dialog box also needs to be selected.

<

To the next page
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€] EntryWDTInt.e 52
/ £
roid

¥ oubput task */

¥Word WriteRtnTask():

P L L s AL Ly

i */

WDT Main processing

roid EntryWDTHMain () |
i

short ret;

F Stsrt rhe wodyle stsbtys wmonitor fask

PRIORITT_Io0,
o,
STLCE,
(FUINCPTE) StatusCheckRtn,
o, o, 0, 0o, 0, 0o, O, 0,
if (ret == ERROR]{
printf ("StatusCheckRthn task start error
return;

o, oy

ret = hd | $hxH 1%

}
/% Scart T output task =/
rec = taskSpawn (TASK NANE Z,

PRICRITY_160,

o,

STACE,

(FUNCPTR) TWord_WriceRtnTask,

o, o, 0, o, o, o, O, O, O, O

if (ret == ERROR){

€] EntrywDTInt.c 52

return;

i

R L s e iy

/* Module status wonitor processing =
lfT***ﬁ‘ﬁ'f***ﬁ‘TT***ﬁ‘TT***ﬁ‘ﬁ'****ﬁ‘ﬁ'ﬁ***%‘Tﬁ***ﬁfﬁ***ﬁfﬁ***ﬁfﬁﬁf

roid StatusCheckRtn ()
{
short ret;
long path;
long plInfo[15]:
long event[4] ;

unsigned long  ulBuf3ize:

/% Execute QBF_Open L

ret = QBF_Open [UNIT, &path):

if (ret != 0)4{
printf ("QEF_Open error ret = %hd [ %hxH )\n", ret, ret);
return;

6. At first, debugging starts at the beginning of the
function specified for "Entry Point:" in the Suspend
status.

« The function specified for "Entry Point:"

<« The location being suspended is highlighted in green.
The display is in the same form as that of when a task is
suspended at a breakpoint described in the step 9.

Insert the breakpoint to a place where a task

operation needs to be suspended.

Adding the breakpoint displays breakpoint information
inserted on the "Breakpoint” window.

Clearing the check box of the breakpoint information on
the "Breakpoints" window disables the breakpoint being

inserted without canceling the breakpoint.
g Breakpoints 52 =0

® %K W, g 7
@, {TestProj/EntryWDTInt 81 #Flanted*, Restricted Scopel

To add a breakpoint, double-click on the left edge of the edit window, at the line where the breakpoint is to be set.
The breakpoint can be removed by a double click once more.
0 0000000000000 000000000000 0000000000000 0000000000000000000000

1S4

To the next page
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CHAPTER 10 HOW TO DEBUG PROGRAM

8. Click the ( [/[=) button to restart the task operation.

%5 Debue 52 =8
- How to see the status of the task operation
) . The following table lists how to see the status of the task
o O IS S i o) , _
. operation based on enabled or disabled status of the
= % Entry'WDTMain = EntryWDTIntout - Wacorkstx: 19216833 [V
= sys-000 (Tazk Mode) three buttons: Resume ( [Ji=), Suspend ( [I[] ), and
-8 tEntry'WDTMain : 0x49382FEC (Stopped)
=" EntryDTMaind - EntryWDTInt.c43 Terminate ( [&] ).
=" vxTaskEntry( - 0xd80406aa
wdl tEntryWDTMain : x49362F BG Button status Task operation status
Suspended status (during suspension)
No.1 Click the [][# button — turns to the status of No.2.
< » Ok ]
= = Click the [Ml button — turns to the status of No.3.
Resume status (during execution)
No.2 Clickthe ||| button — turns to the status of No.1.
(W) IE
Click the [Ml button — turns to the status of No.3.
No.3
Termination status (debugging terminated)

284

T 9. The task operation goes into the Suspended status

/% Module status monitor processing at the point where the breakpoint was inserted in

l,."ﬁﬁﬁWTTWTTTT1?1?1?1?1?1?1"1"1"1"1"1"TTTWTTWTTTTTTTTTTTTTTTTWTTWTT? .

roid StatusCheckEtn () the step 7, and the operation has stopped.

{
short ret; Conti deb . b ti h hecki
Long path: ontinue debugging by operations such as checking
long plInfo[15]; variables with step through execution and changing
long event [4] ;

unsigned long ulBufiize; variables.

/T Ewecute QBEF Open

ret = QBF Open (UNIT, &path):;

if jretc != 04
printf ("QEF_Open error ret = 3hd [ $hxH 1hn",
return;
1
10. Use the followin step execution buttons on the tool
g9
Debueg &3 . .
ke button on the "Debug" window to continue
=
debugging.
wi e O S - i )
= % Entry'WDTMain — Entr WD TIntout - WlorksGx 19216833 [V Icon Description
= sye-000 (Task Made Step Into
=&y SmpTaszk_1 : 1:49CE3074 (Stopped - Breakpoint Hit) . Steps into the called function and stops at the first line
; of the function.
- Dx480495aa Step Over
'@,f SmpTazk 2 : 0x4FFFAFAC (Running) ik Executes the current line of the function and then
@ <terminated, exit walue: 285245t Entry'WDTMain : 0x49382 F B stops at the next line of the function.
Step Return
N Continues execution until the current function has
¥ 5 returned to its caller.

1S4
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)= Wariablez &3 it Registerswﬁ"g" Expressionsw ﬂ Memory Browser | =

R (T T R R T
Mame Tvpe Walue
()= ret shart int -1
()= path lorg irt 12282659265
B & pivio T
B = event  long int[4] 0x49339FEC
(= evel long int -286331154
()= evel lone it -286331154
()= evel long int -286331154
(9= evel long int -286331154
(9= ulBuf3i; lone unziene. OxEEEEEEEE

Mame plInfo

Binarv:0b01001001001110001001111110000000

E

)= Variables | ifi} Registers 53 & Expressions} ﬂ Memary Browser | — O
EE B T8 7
MHamea Walue Description N
= &4 General General
diar 10 000000000 £
il 3 ]
OxdQB82FBC
Dx4Q36EFC4
Q40000000
Q48202 B3
0000000396 b
L) | =
MName : rl |
Binary:0b010010010011100000101111131301100
Decimal:12258419052 B
Hex:0x49352FEC bt

()= Variables | i1} Registers (5’,2" Expresgions 53 [ Memaory Browser} =08

EE B R R (67

Expreszion Tvpe Yalus Name : path
Einary:0b01001
= (= event long int[4]  0x49389FBC Decimal:12282°5
()= event[0]  lone int -286331154 Hex:0x4935EFCY
9= evert[1]  long int -286331154 Default:12252°
9= event[2]  long int -286331154 Ootal:01111533

()= event[3]  loneg int -286331154 String:

A mew axpr

S e

T T=

=8

s o
[y

| [NewTab]

()= Variables (H'H' Registers (539" Expressions (ﬂ Memory Browser 53

[DxEC000000

0xEG000000 &3
OxECOOO000

OxECOOOCOC
OxECOOO01S
OxECOOO0Z4
OxECOOO030
OxECOOO03C

12545678 00000000 00000000
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0
00000000 00000000 aoooooo0

1S4

To the next page

B

=

£
|
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= 11. Clicking the <<Variables>>,

<<Registers>>,<<Expressions>>, and <<Memory
Browser>> tabs during suspension of tasks
displays each window. Checking and changing
values allows efficient debugging.

"Variables"
Displays the current values of local variables.
"Registers"
Displays the current values of registers.
"Expressions"
Displays the current values of variables in the
Watches window.
"Memory Browser"
Displays the memory dumps on the C Controller
module.

The color of cell changes to yellow when the value has
changed from the previous value by step through
execution or when the value has been changed.

On "Memory Browser", the color of cell does not
change, but the color of font changes to green.

On "Memory Browser", timing to refresh values can be
selected unlike other windows.

Right-click on the "Memory Browser" window. Select
[Update Mode] from the pop up menu.

Always update

Iz Radix b Browser 53 =g

Columns 4 [
& Almays il

] On Breakpoint

300 Mar};al

(n]n Copy fddrezz /7 | L. ... ~

ac Fezset To Baze Address | L. ... ... ....

oo Refresh 7 | o e oo e,

AlAn nnnnnnyﬁ [(alalalnlnininlsl

Update during suspension
with a breakpoint inserted

Manual update (Refresh)
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12. Placing the mouse over a variable for a certain

/% ERegister timer event of 500wms cycle w4
/% Timer event count s . . .
Trpe Value * period of time displays the current value of the
lore int[¢] 0x43388F BC L ” . .
lang int 286331154 =l variable in a balloon.
long int a . .
_ lone int ~208331154 The value displayed in the balloon can be also
9= mvent[3] long int 286331154 ) ; .
=ve rer changed like on the "Variables" window.
¥
/% Register a routine for the user WDT error incerrupt. L7

ret = (BF _EntryWDTInt (path, 0, (FUNCPTR)WDTIntHookRtn):

,ﬁ — > = E'\ 13. Click the Terminate ( [@] ) button on the "Debug"
e window to terminate the debugging session.

Al R

T T = N S
= % EntryWDTMain — TestProjout — Wibiorl,
= m8 SHTTAN (Tazk hads)

284

Completed

Point/’

To debug the task again, click the W mark on the right side of the debugging icon ( ﬂﬁ“j; ) on the toolbar and select the

created debug configurations at the top of the pop-up menu.

The steps 1 to 5 can be skipped. 23
% Device Debue — EntryWDTInt/EntryWDTInt.c — GW Workbench i;
File Edit Source Refactor Mavieate Search  Project  Target  Bun Window  Help g’%
g3
= = = : : 3" A P | a1 . Q
Nuillely @ OiP-0-Q% ¥ GOS8y W S0 Sg
| (T o s . N 4 — o &
I_\-i"_‘l Project Explorer &3 [ Del:uu4 1 EntryWDTMain ~ EntryWDTIht.out % cE:u
— ~ 3
Debug A= 3 55
73
Debug Configurations... 3
- Entry'WDTInt_partiallmage. Drganize Favorites.. ;:
m 1

[El EntryWDTIntout SH7 7E0emme—rremmer il
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10.4.2 Debugging multiple tasks

94

(1) To debug multiple tasks, execute steps 1 to 5 in "Section 10.4.1. Debugging
one task" as many times as the number of tasks to be started.

(2) The "Debug" window displays the executed tasks.

EI An example of when two tasks have been started

[€] EntryWWDTIte 52

return;
H

P
i T word output processing
JEnaa AR R TR TP ET PR

¥iord WriteRtnTask()

short retc;
long path;
unsigned short datall];

/%  Execute QBF Open L

ret = QBF_Open (UNIT, é&path);

if (rec '= 0){
printf ("CEF_Open error ret = %hd ([ %hxH )\n", ret, ret);
return;

+

AR AT AR ARTAATARTAATAREAATIARRATIARARTAATARTAATARS
/% Inerement ¥0 - YF every one sSecond ¢
SRR R R R AR AR R AR R AR R AR R AR R AR R AR R AR TR AT AR TR AT AR AK S

data[0] = O;

= O || %5 Debug £2
% i3

=0

B i e 7

T R R B

=& SHI780 (Task Mode)
=@ EntryWOTMain - 0x43362FBC (Stopped!
=" EntryWDTMain( - EntryWDTint c:d4
=" wxTaskEntry) - 043048633
{ | tEntry WO TMain : 0x48302FBG

(o % EntryWDTMain = EntryWDThntout - Wehiorksix 19276833 [Whiorks Kernel 1)

=52 SHT780 (Task Mode)
= @y 1Word WriteRtnTask - 0x4FFFSES0 (Stopped — Breakpoint Hit!

=" vxTaskEntryd - 040049622 A

B tYWord Wirit=RinTask - 0x4FFFSESD

(= U iord WviteRtnTask - ErtryWDTIntout - \axliorkstix 19216833 [uxiiorks Ke)

The task 2 function is in the Current
status.

The source code in the left dialog
box shows the breakpoint.

while (1) {
F* TWrite ¥0 - ¥F wvalue /
ret = (BF_Y Out WordEx(path, 0, 0, 1, data, 0);
ifjret = Oj{
printf ("QBF_¥ Out_WordEx error ret = %hd ( *hxH 1hn'", ret, r
break:; — >
(3) To debug another task, use the mouse to select another function on the
" " H
Debug" window.
Switch tasks while multiple tasks are being debugged.
An example of when switching from the task 2 to task 1
€] EntryWDTe 52 = 5| %5 Debug 52 =g
3 O (] B & 3D . B i € 7
47 ouepue task */ ([ = C ErtryWDTMain — EntryWDTIntout - VidWorkstix 19216833 [Vlorks Kermel Task]
roid YWord WriteRtnTaski): = SHTTE0 (Task Moded
-8y tErtry WD TMain : Dx49382F BG (Stopped)
/xwxxwxxwxxwxxwxxw:xwxxw:xxxwxxwxxwxxw XX En &
e e = xTaskEntryl - Dalibiston A
- - g AEniryWDTMain : 0x49382FBC
void EntryWDTHMain () = Uy Yllord Write FArTask, — Entry WO Intaut — WjWorksbx_192.1868.3.3 (woiorks Kernel
= &P SHTTB0 (Task Mode)
short  rec; =84} tr¥iard W ite Rt Task : (et FFFSESD [(Stapped ~ Ereakpoint Hif)
- — =' “iord_Wirite Fitn Tazk O - Entry WD TInt.c167
/% Zrart the module Status monito * = s Task Ertry( - 0x43049633
ret = ERERSPm (TASE NAME 1, W triard WriteRinTazk : (d FFFEESD
PRIORITY_150, . g
o,
STACK, —
[FUHCETR) StatusCheckRen, The task 1 function is in the Current
a, o, o, o, o, a, a, o, o, 0): StatUS
if (ret == ERROR]{ ) L
printf ("StatusCheckRtn task start error ret = %$hd [ $hxB The SeIeCtEd fUnCtIOn IS now
return; displayed.
3
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10.5 How to Execute Dynamic Printf

This section explains how to execute Dynamic Printf.

Dynamic Printf is a function to dynamically insert or cancel the printf statement when debugging the program without
embedding the printf function to the source code with the similar operation as that of the breakpoint.

Dynamic Printf is only compatible with Q24DHCCPU-V/-VG.

J@ AtomTestProcpp &7

short mdTest (void) {
long path = 0O;
Toeele Breakpoint )

¢ fdd Dvnamic ‘printf’.

Breakpointz 3
Tracepoints 3

Add Book mark...
Add Tazk. .

w  Show Quick Diff Ctr H+Shift+)
Show Annotation
Show Line Mumbers

Falding 3

Preferences..

1S4

® Dynamic 'printf' Properties

Dynamic "printf' Location and Arguments frj

elzct debug target for target-specific information

Mone — presetve current ssttings

Gereral | Source Lookup | Status|  Scope | Advanced|
Path Type @® Project System O File System
Fils Path B, [/ATOMTest/AtomTestPro.cpp

| [Browse. |

Line |08 |

Printf (. |* path=3d" path |
Enabled

[ verbose Mode

Ccondition | ]
[ skip Gount | |
@

1S4

To the next page

1.

On the "Editor" window, open the source file which
is a target for debugging, and right-click the left
edge section

to open the pop-up menu.
Select [Add Dynamic 'printf'...] from the pop-up
menu.

The "Dynamic 'printf' Properties™ dialog box
appears.

Enter the printf statement to be displayed when
debugging the program for "Printf (...)" with the
same text format as the argument to be written in

the printf function, and click the button.

95
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Bg Breakpoints 53 =0

XEPFA | mET T

U printf " path=%d" path} /ATOMTest/ AtomTestPro.cpp 208

® Debue Gonfieurations

Create, manage, and run configurations ﬁ

B 2.
B x End Mame: [mdTest - O24DHGCPL-Y SHaut - GR4DHCGPU-Y sh
fipe fiter text i 5
£l 18 Launch Gontext | ) Domnloads [ Projests to Build | & Sourse | ) Gammen
=48 Attach Tareet Context S
89 Q2DHCCPU-V_SH HI ot
%9 Q24DHCCPL-V_SH HO? (1) Olgeal fil
[E] G/C++ Application OShared file: | ][ Erowse.
[£] G/G++ Attach to Application
[E] G/0++ Postmortem Debusser Display in favorites menu Gonsale Encoding
[E] G/G++ Femote Application O %5 Debue (@ Default - inherited (M5932)
7% Launch Control O QRN Oover [Eosm
Gy Vidrks Kemel Task [0 3 Domnioad
G mdTest - Q24 DHCCPURY SHow
G alorks Real Time Frocess Standard Thput and Qutput
[F1iAliaE st Corisole ecessary for ot}
[File: |
workspace.. | [File System. | [ Variables..

3. The printf statement entered for "Printf (...)" is
added on the "Breakpoints" window.

The execution result is displayed on the "Console"
window.

=> To display the result of Dynamic Printf on the "Console"
window, select "Allocate Console (necessary for input)"
on the <<Common>> tab of the "Debug Configurations"
dialog box.
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CHAPTER 11 TROUBLESHOOTING

The following table lists errors that occur during use of CW Workbench and their solutions.

Category

Problem

Reference

Basic operation

The CW Workbench installer has stopped working half way through. Or the installer has
terminated suddenly during installation.

Page 98, Section 11.1 (1)

A message "The install root of your Wind River Workbench installation could not be
located!" appears and CW Workbench cannot be started.

Page 98, Section 11.1 (2)

A message "Workspace in use or cannot be created, choose a different one." appears
and CW Workbench cannot be started.

Page 98, Section 11.1 (3)

A patch has been applied, but the display does not change.

Page 99, Section 11.1 (4)

The install menu of the plug-in software cannot be found.

Page 100, Section 11.1 (5)

Help on an FTP server does not open.

Page 101, Section 11.1 (6)

The message "The application was unable to start correctly (0xc0000142). Click OK to
close the application." appears and the debug function cannot be used.

Page 101, Section 11.1 (7)

You have received a permanent license file, but do not know how to use it.

Page 102, Section 11.2 (1)

You do not know how to delete a permanent license file.

Page 102, Section 11.2 (2)

License
An error message with a title of "License Not Found" appears when CW Workbench is .
. Page 102, Section 11.2 (3)
started or being operated.
An error "command not found" has occurred and the build is not executed. Page 103, Section 11.3 (1)
An error "no input files", "No Such file", or "No such file or directory" has occurred. Page 104, Section 11.3 (2)
An error "Build target "/ /nnnn_partiallmage" used in build target " " not found" has
get Tyyyy/nnnn_p g get yyyy Page 104, Section 11.3 (3)
occurred and the build is not executed.
The following build errors have occurred:
Building "xxx.sh: syntax error near unexpected token "yyy partiallmage/Debug/Objects/nnn™

"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"

"yy.o: command not found ... No such file or directory"

Page 105, Section 11.3 (4)

.out file is not created.
The build terminates with a message "Generation of makefiles started."

Page 105, Section 11.3 (5)

A build error "expected expression before '/' token" occurs.

Page 106, Section 11.3 (6)

Target server

CW Workbench cannot be connected to the C Controller module.

Page 107, Section 11.4 (1)

When "Connect" is executed on the "Remote Systems" window, an application error
occurs and CW Workbench cannot be connected to the C Controller module.(Failed to
Connect to Target)

Page 108, Section 11.4 (2)

connection .
The connection status of the Remote Systems suddenly changes from "Connected" to
"Disconnected".
The selected target connections are not imported. Page 108, Section 11.4 (3)
.out file cannot be downloaded on the C Controller module. Page 109, Section 11.5 (1)
Downloading

.out file sometimes cannot be downloaded on the C Controller module.

Page 109, Section 11.5 (2)

Installation using

a temporary After an LAC code and user information are entered and the button is Page 110, Section 11.6 (1)
license clicked, an error message appears and the installation does not progress.
Firewall A firewall warning message appears when CW Workbench is being operated. Page 110, Section 11.7 (1)
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11.1

Basic Operation

(1)

(2)

@)

98

The CW Workbench installer has stopped working half way through. Or the

installer has terminated suddenly during installation.
This problem occurs when characters other than alphanumeric characters, an underscore "_", and a hyphen "-"
have been used for the folder name of the installation location specified at first on the CW Workbench installer.
 Action
Use the following characters for the folder name of the installation location and reinstall CW Workbench:
* Alphanumeric characters
 underscore "_", hyphen "-" (Space cannot be used)

A message "The install root of your Wind River Workbench installation could
not be located!" appears and CW Workbench cannot be started.

This problem occurs when characters other than alphanumeric characters, an underscore "_", and a hyphen "-"
have been used for the folder name of the installation location on CW Workbench.
* Action
Uninstall CW Workbench. Use the following characters for the folder name of the installation location and
reinstall CW Workbench:
* Alphanumeric characters

 underscore "_", hyphen "-" (Space cannot be used)

A message "Workspace in use or cannot be created, choose a different one.”
appears and CW Workbench cannot be started.

This message appears if the folder of the workspace specified at first is being accessed by another CW
Workbench.
* Action
Click the ] button. Select a different folder for the Workspace folder displayed again or
terminate the CW Workbench that is operating already.
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(4) A patch has been applied, but the display does not change.

Old data may be in the cache.
+ Action

When starting CW Workbench, specify "-clean" in the argument.
After CW Workbench has been started with "-clean" specified, delete "-clean" from the boot argument.
(Keeping "-clean" being specified slows the startup of CW Workbench.)

(a) How to specify "-clean"

CW Workbench Properties

General | Shortcut |C0mpatibility || Sec:urityl

I@ Cw wiorkbench

Target type: Application

Target location: eclipze

Target: |rm\x8B-win32'\ec:|ipse\wrwb-xSB-winSZexe -cleany

Start in: |C:\WindHiver |

Shortcut key: |None |

Fiur: | Mormal window b |

Cammet: | |

[ Find T arget... ] [ Change lcon... ] [ Advanced... ]

I Ok ] [ Cancel ] [ Apply

(b) How to delete "-clean"

1.

Select the CW Workbench shortcut on the desktop.
In the menu that pops up by right-clicking on the
shortcut, select [Properties].

Enter a space at the end of "Target:" on the CW

Workbench Properties.
Enter "-clean" after the space and click the

k. button.

In the step 2 of [How to specify "-clean"], delete the space and "-clean". Click the ak button.

99
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(5) The install menu of the plug-in software cannot be found.

To install the plug-in software, select from the menu bar [Help]=>[Install New Software...].
If [Install New Software...] cannot be found on the Help menu, the display mode of CW Workbench is "Basic

Device Development".

Check the current display mode of CW Workbench on the title bar.

%% Basic Device Development — CW Workbench

File  Edit Source

Refactor

* Action

Mavigate Search

Project  Bun  Window  Help

Change the display mode of CW Workbench to "Advanced Device Development".

(a) How to change the display mode

m Help

Mew Window -
Mews Editar PVl

Open Perspective
Shiov Wiew »

velopment

T Bagic Device Development
@ Device Debug
EH Remate System Explarer

4 o+ - D w

Import Perspectives..
Export Perzpectives..

Custamize Perzpective..
Save Perzpective fz.

Cither...

[ B Advanced De.. |E >
=0)

= i B Advanced Device Development

[ Bagzic Device Development
[5 Device Debug

Other..

1S4

% Advanced Device Development - - CW Workbench

Fil=  Edit Source PRefactor Mavieate Search  Project  Target Bun Window  Help

<

Wielcome

E {#) Help Gontents
7 3 Search
Cwnamic Help

Kev fizzist. Cr[+Shift+L
Tips and Tricks..

Cheat Sheetz..

Check for Updates
Inztall M f

() Getting Started

100

1.

Select from the menu bar [Window] => [Open

Perspective] => [Advanced Device Development].

Another way to change the display mode is click the

Open Perspective icon ( @ ) at the upper right corner

of CW Workbench and select "Advanced Device
Development" from the menu displayed.

Check that the title display of CW Workbench has

been changed to "Advanced Device Development".

To install the plug-in software, select from the menu

bar [Help]=>[Install New Software...].
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(6) Help on an FTP server does not open.
'Failed to launch help' is displayed and Help does not open even when 'HELP' is selected in the menu of the FTP

server included in this product.
The currenly used operating system may not support the FTP server included in this product.

 Action
Check if the currently used operating system supports the FTP server included in this product.

[T Page 17, Section 2.3

(7) The message "The application was unable to start correctly (0xc0000142).
Click OK to close the application.” appears and the debug function cannot be

used.
This symptom occurs when using Windows 10 version 1703 (Creators Update), and the following functions
cannot be used.
 Target connection function (The connection with a target cannot be performed.)
» Debugging function (Debug cannot be executed.)
* Action
Apply Windows update KB4025342(0OS Build 15063.483) for Windows 10 version 1703 (Creators Update)
for a personal computer.

uoneladp ai1seg L1
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11.2 License

102

(1)

(2)

()

You have received a permanent license file, but do not know how to use it.

Store the obtained permanent license file in the license folder in the personal computer where CW Workbench
has been installed.

[~ Page 26, Section 5.3

You do not know how to delete a permanent license file.
Delete all the files in the license folder in the personal computer where CW Workbench has been installed.
[ Page 27, Section 5.4

An error message "License Not Found" appears when CW Workbench is
started or being operated.

An error has occurred with the license file being used for CW Workbench.
[ Page 115, Appendix 2
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11.3 Building

(1) An error "command not found" has occurred and the build is not executed.

A compiler that cannot be used on CW Workbench has been selected.

* Action
From the tree view to the left on the "Properties" window on the "Project" menu, select "Build Properties" and

click the<<Build Support and Specs>>tab. (The window shown below is the one that appears when the

project name is "UserProject".)
Check that the compilers that cannot be used have not been selected for "Available and enabled build

specs:".
Since the "Available and enabled build specs:" supports only the following build specifications, clear the

check boxes other than the following build specifications.
> For Q24DHCCPU-V/-VG: "PENTIUM4gnu"
2> For Q12DCCPU-V: "SH7750gnule"

% Properties for UserProject _ E

Build Properties

1

|type filter text

SOurce Specify all build properties.

@ Euild Support and Specs | 4 Build Tools | $ Build Macros | (5 Build Paths | =4 Libraries |

Build support
(& Manaeged build  {makefiles generated by the IDED

operties
- Builders
- GAT+ General
- Project Info

. Project References () Dizabled

- Refactoring History

- Fun/Debug Settings Build command: P ro—orirded

- Task Tas %makepreficl make ——no-print-directory
- alidation

freailable and enabled build specs:

ial nable
[ s5H7750diab Enable All

[] sH7750diable
[ aH7780enu Dizable All

SHTTEenule

Fename...

Buipiing €711

Copy...

Delete..

Default build spec: |SH??EDgnuIe v|

Active build spec: |SH??EDgnuIe w |
Debug mode

Restore Defaults
@ [ ok |

Cancel ]
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(2) An error "no input files", "No Such file", or "No such file or directory" has
occurred.

The source file may not have been registered in the build project.
+ Action
Create a file with extension of ".c" or ".cpp" or change the file name to the one with extension of ".c" or
".cpp". Register the file in the build project and execute the build.
[ 7 Page 56, CHAPTER 8
Follow the instruction below to change the file name.

» With "Sample" selected, select [Rename] from the menu that pops

Eile  Edit Source Refactor Mavieate Search  Project  Bun Window  Help . Lo
up by right-clicking.

Ailwi @ P%-0- 14 a0 g S
ﬁ*_‘,PrDject Explorer &2 =] Q:D &7 "0|@
& EntryWDTInt (Wind River WxWorks 6.4 Downloadable Kernel Module Project) * Select "Sample" and press the I key

=] tg' UserProject (Wind River Wiorks 6.4 Downloadable Kernel Maodule Project)
{E Build Targets (SHT7E0enule)
g
{5 Wind River Launches
1‘,—? Binarie=
[t heludes
(7= SHT7a0enule

=22 TestProj (Wind River WiWarks 6.4 Downloadsble Kernel Module Project) I

= cample

Mew 3

Cpen
Cpen With 3

[{Z Copy Citr [+

¥ Delete Delete

Move...
Attributes >

(3) An error "Build target "/yyyy/nnnn_partiallmage" used in build target "yyyy"

not found" has occurred and the build is not executed.
The file with the same name as the project name may have been renamed.
+ Action
Create a project and move the source file from the project where an error occurs.
[ > Page 56, CHAPTER 8

Point />

The following message appears when the project where an error occurs is deleted. Check if the box is selected or cleared.
Do not delete the necessary file by mistake.

Clicking the 0K button with the box cleared ([])

9 ) Are you sure you want to remove project '‘Sample’ from the workspace? deletes the pI'O]eCt from the Workspace. The file remains on
&’/ the hard disk.

[Jibelete project contents on disk (cannot be undones:

% Delete Resources

Clicking the OF. button with the box selected

([+]) deletes the project from the workspace. The file is

Presriew > ] [ 0K ] [ Cancel ]

deleted from the hard disk at the same time. (The deleted file
cannot be recovered.)
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(4) The following errors occur:
"xxx.sh: syntax error near unexpected token 'yyy partiallmage/Debug/Objects/
nnn"
"xxx.sh: cannot execute binary file"
"Makefile:xxx: *** missing separator. Stop"
"yy.o: command not found...No such file or directory"

The source file name may have symbolic-characters.
+ Action
Remove the following symbols and characters that cannot be used from the file name with an error message

nnn and from the name of the source file added to the project.

Symbols/characters that cause a build error

# Sharp sign

Ampersand

Apostrophe

( Parenthesis

) Parenthesis

Semicolon

= Equality sign

Grave accent

Two-byte characters

Katakana

The following symbols that cannot be used for file names on Windows also cannot be used for the source
file.

Symbols that cannot be used for file names on Windows

\ Backslash

/ Slash
Colon

* Asterisk

? Question mark

" Quote

< Less than

> Greater than
Pipe

(5) .out file is not created.
The build terminates with a message "Generation of makefiles started."

The source file name may have a dollar sign "$".
* Action
Remove "$" from the source file name.
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(6) A build error "expected expression before 'I' token" occurs.

"/" may be commented out in the source code.
* Action
Configure the setting to comment out "//".

(a) Setting procedure
Configure the setting by following the procedure below so that single line comments can be compiled.
1. Selecta project to which property is to be set in the "Project Explorer” window, and select
[Project] => [Properties] in the menu bar.

2. Select [Build Properties] from the tree on the left on the screen, and select the <<Build Tools>>
tab.

3. Check that "C-Compiler" is set for "Build tool:".

4. Delete "-ansi" from "Tool Flags...".

Point/’

This setting needs to be configured for each project. If there are multiple target projects, apply the same setting to all the
projects.
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1.4 Target Server Connection

(1) CW Workbench cannot be connected to the C Controller module.

(a) Case 1: [Log Console] A message "Differences for module "xxxxxxx" segment's

address" appears.
The VxWorks image file of the C Controller module is not the same as that of CW Workbench.
+ Action
The VxWorks image file of the C Controller module must be the same as that of CW Workbench.

[ 7 Page 76, Section 9.1

(b) Case 2: A message [Failed to Connect to Target] appears.
The C Controller module may not be connected to the CW Workbench network or the IP address setting may
be wrong.
+ Action
Check the following items:
* The C Controller module is on.
» The C Controller module is properly operating. (There is no error.)
» The LAN cable connector connecting the development environment (personal computer) to the C
Controller module has been fully inserted into the LAN socket.
» LEDs of all the LAN ports to which LAN cables are connected are lit.
« IP addresses of the development environment (personal computer) and the C Controller module have

been set properly.

Point/’

If the problem is not solved by applying the corrective actions shown above, delete the cache folder and restart CW Workbench.
(It may take time to startup at the first time after deleting the cache folder.)

® Cache folder
"C:\Documents and Settings\User name\.workbench-3.2.X.XXXXXXXX-XXXX"
User name: The user name currently logged on
x: A value added automatically

(c) Other causes
The host name of the development environment (personal computer) where CW Workbench has been installed
may have only one character or more than 15 characters or may have two-byte characters or one-byte
katakana.
+ Action
Set the host name of the development environment (personal computer) within 2 to 15 alphanumeric

characters.
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(2)

()

When "Connect" is executed on the "Remote Systems" window, an error
occurs and CW Workbench fails to be connected to the C Controller
module.(Failed to Connect to Target)

The connection status of the Remote Systems suddenly changes from
"Connected" to "Disconnected".

This error occurs when: "Connect" has been executed on the "Remote Systems" window of CW Workbench on
multiple personal computers for one C Controller module, or "Connect" has been executed on the "Remote
Systems" window of CW Workbench multiple times on one personal computer for one C Controller module.
* Action
Do not execute "Connect" on multiple personal computers to one C Controller module at the same time.
Do not execute "Connect" on the Remote Systems window of CW Workbench multiple times to one C
Controller module.

The selected target connections are not imported.
This error occurs when: the multiple target connections are selected, and the import operation is executed.
* Action
Import the target connections one by one which are not imported.



CHAPTER 11 TROUBLESHOOTING

11.5 Downloading

(1) .out file cannot be downloaded on the C Controller module.

[Problem Occurred] message
Possible Cause:
Download failed.
The path or the file name of the .out file to be downloaded has characters or symbols that cannot be used.
+ Action
Remove the following symbols and characters from the path or the file name of the .out file to be
downloaded. Select the file again and download it.

Downloading fails if an .out file has the following symbols/characters for the path and the file name:

' Apostrophe

* Asterisk
Colon
Semicolon
Period

< Less than

> Greater than

/ Slash

? Question mark

Space

Two-byte characters

Katakana

(2) .out file sometimes cannot be downloaded on the C Controller module.
The path of the VxWorks image file selected for the target server setting may have two-byte characters or
katakana.

+ Action
Remove two-byte characters and katakana from the path of the VxWorks image file.

[T Page 76, Section 9.1
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11.6 Installation using a temporary license

(1) After an LAC code and user information are entered and the | pext > |

button is clicked, an error message appears and the installation does not
progress.

Error message

2 Error Message §|

Errors occurred while trying to verify the entered License Authorization
Caode (LAC)

« Action

The following table describes how to respond to the error text displayed in the "Error Message" dialog box.

Error text Action

The HTTP server you are trying to access may not be responding properly.
HTTP Server: Bad Gateway Try to install the product later.
If the problem still remains, try to install the product another day.

The personal computer in use may be connected to the Internet via a proxy server.

Unknown Host: Use the button and go back to the "Online Update Settings"

window. Check the box of "Connect to the Internet using a proxy server" and
configure the proxy server setting.

The personal computer in use may not be connected to the Internet.

Check that the personal computer can be connected to the Internet.

Unable to read repository at Install the product on the personal computer being connected to the Internet.

When the personal computer is connected via a proxy server, conduct the measure of
the error text (Unknown Host) above.

Atemporary license may be expired on the personal computer in use. Perform the
HttpComponents connection error | installation with an installation key file or a permanent license.

response code 500. If the problem persists, please contact your local Mitsubishi Electric sales office or
representative.

11.7 Firewall

(1) A firewall warning message appears when CW Workbench is being operated.

A warning message indicating that a function of CW Workbench is blocked may be displayed by the Windows
Firewall.

Allow the access by following the procedure below:

(a) Setting procedure

1. Select the checkbox of the network type being connected (private or public network).

2. Click the [Allow access] button.
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APPENDIX

Appendix 1 Installation and Uninstallation of the Plug-in
Software

This section explains how to install and uninstall the plug-in software, an extended function of the product.

For details on the plug-in software functions, refer to the following Wind River Workbench document provided by Wind River
Systems, Inc.

O Click the menu bar [Help] => [Help Contents] => "Wind River Partners Documentation" — "Eclipse

Workbench User Guide" — "Tasks" — "Updating and installing software"

Appendix 1.1 Installation

Follow the instructions below to install the plug-in software.

Point /s’

® When installing the plug-in software, check that the product is in the "Advanced Device Development" mode.

% Advanced Device Development — - C'W Workbench

File Edit Source Refactor Mavigate Search  Project  Targ

If "Basic Device Development" is displayed on the title bar, change it to "Advanced Device Development" by one of the
following methods:

+ Select from the menu bar [Window] => [Open Perspective] => [Advanced Device Development].
» From the menu that appears by clicking the Open Perspective icon ( %}' ) at the upper right corner, select
[Advanced Device Development].

@ The plug-in software install method explained in this chapter is the same as the general install method of Eclipse3.5. To
install the plug-in software, follow instructions provided by plug-in software manufactures.

@ For details on how to use the plug-in software installed, contact the plug-in software manufacturer.

@ |[f the installed plug-in software does not properly operate, check if the software can be operated in Eclipse3.5 on public
operating environment provided by the plug-in software manufacturer.
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Weloome
(?) Help Contents

jﬂ?’ Search

Dyvrnamic Help

kew fzsizt. Ctr+shift+L

Tipz and Tricks...
Cheat Sheets...

Check for Updates

<

1. Toinstall the plug-in software, click the menu bar

[Help] => [Install New Software...].

2. Clik the Putton on the instal
window.

Available Software
Select a site of enter the location of a site.

odl

Bdd.. ]

type or select a site vl L

iork, with
Find more software by working with the 'fvailable Software Sites' preferences.

|type filter text

Name Wersion

1@ There is na site selected

Detailz

[¥]Shaw only the latest verzions of available coftware [ ] Hide items that are already installed

[¥] Group items by catesory What i already installed?

[¥]Contact all update sites during inztall to find required software

Mext > Einizh

Cancel

< Back

@

|| | [ Local..

Mame:

Location: |I'1tt|3:,"1-’r | [ frchive..

J
]

a4

@

Cancel

3. Enter information for the Name and Location fields.

Click the (] | button. A web site where the

plug-in is software installed is added.

An Archive file downloaded from the web site can be also selected for the "Location" field by clicking the

pution

<

To the next page
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—: Package that can be installed from the added
% Install =5 E]E‘
Available Software r;' Location is acquired.

Select a site or enter the location of a =ite. "Pending..." is displayed as Shown on the window

to the left while the information is being acquired.
Wiork with: |type or select a site vl | Add.

Find more software by working with the 'fvailable Software Sites' preferences.

|type filter text |

Name Wersion
[] Pending

Detailz

[¥]Shaw only the latest verzions of available coftware [ ] Hide items that are already installed
[¥] Group items by catesory What i already installed?

[¥]Contact all update sites during inztall to find required software

@ < Back Mext > Einish

284

& nstall CEX 5. When the package that can be installed has been
Available Software g acquired, package names are displayed.

Select a site of enter the location of a site. Select a package tO be insta"ed.

Clickthe [ Mext > button to install the

Work with: [tvpe or select a site v| L Add.. J

Find more software by working with the 'Available Software Sites' preferences.

plug-in software.

|type filter text |

Name Wergion
[]000 Babel Languzge Packs in Italian
abe| Lany J =

[]000 Babel Laneuzes Packs in Klingon
[]000 Babel Langusge Packs in Korean

Detailz

[¥] Show only the latest versions of available software [ ] Hide items that are already installed
[¥] Group items by catesory What is already installed?

[ Contact all update sites during install to find required software

uone|jeisu| || xipueddy

alemyog ul-Bniq ay) Jo uone|eIsuIun pue uone|elsy] | xipuaddy

@ < Back Mext > Einish

284

Completed
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Appendix 1.2  Uninstallation

Follow the instructions below to uninstall the plug-in software.

Select the menu bar [Help] => [About CW

1.
H.H ‘ H.H Q ‘ Workbench Features].

Click the button.

CIEI 1

@ Installation Details

: 2. Open the <<Installed Software>> tab and select the

packages to be deleted.

Click the button to uninstall the plug-in
Mame Wersion Id 23

LI software.

Installed Software | nstallation History | Features | Plug=ing | Gantiguration |

abel Laneuase Pack for mode 7.,
Babel Language Pack for modeling mz 3500200531

orgeclipseba
| >

|1

[ Update... ][uninstall... J Properties

284

Completed
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Appendix 2 License Errors

This section explains license errors that may occur when CW Workbench is started and being used.

Appendix 2.1 License errors

CW Workbench operates as below when a license error occurs at start-up and during use.

(1) Click the |

* The license is repeatedly checked.

{ button on the License Not Found dialog box.

(2) Click the Cancel | button on the "License Not Found" dialog box.

* The license check ends and CW Workbench continues to operate.

If the Cancel button is clicked with license errors occurred and CW Workbench continues to

operate, CW Workbench operates with the following functions disabled:

Functions that cannot be used Functions that can be used
when a license error occurs even when a license error occurs
* Project creation « Editor function (such as new creation, editing, saving, and
* Building searching)
« Target server connection « Importing
» Downloading « Exporting
» Debugging

SJ0JI 3suadI | Xipuaddy
$10113 9suddIT g Xipuaddy
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Appendix 2.2 License error message

When a license error occurs, an error message "License Not Found" shown below appears. Check error details based
on an error number.

b License Mot Found El

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
license: Overall Licenze for the Wind River Warkbenich

1) »| Cannot find licernse file
The licenze files or zerver netwark addreszes) attempted are
2) » lizted below. Usze LM _LICERSE FILE to use a different licenze file,
of cohtact wour software provider for a license file
Feature: WE_MIOREBEMCH
Filename: o licenze¥WRSLicenze lic
3) p| Licenze path: C¥WRECWANE|icenee CWRECWMAN 2% license, G iOP_B¥licenze;
Co¥ M ELS ECEC MY licenee G0 P licenze,G¥Wind River¥licenzeC#ind River —
¥license¥zwrzlicenze lico¥¥licenze¥WRS Licenze lic
4) p| FLE®Im errar: —1,359.| Swstem Errar: 2 " Mo such file or directary” < 5)

Far further ntarmation, reter to the FLEXIm End Lzer Manual,
available at T macrovizion.com”

i Hetry |[ Cance!

No. Item Description
1) | Error text Displays an error outline within 80 characters.
2) | Error details™ Displays error details and solutions/measures within 3 to 5 lines.
3) | Support information”! Information such as a license file name and path information

Displays the error number and minor number of a license error case.(A number used
when an FLEXIm vendor provides support. This guidebook omits explanations.)

e FLEXIm error: O, A

) ) O : Error number (-1 to negative number)
4) | FLEXIm error information

A : Minor number (1 to positive number)
In the error message above (FLEXIm error: -1,359)
Error number: -1
Minor number: 359

Indicates the latest error number and error text of the operating system acquired before a

5) | System error information L
license error.

*1 These items are not displayed for the specific errors.

116



APPENDIX

Appendix 2.3 Main license error messages and recovery
procedures

This section explains license errors that may occur during operations of CW Workbench and how to recover from
errors.

(1) Trial period expiration
If CW Workbench is used with a temporary license, the following license error message appears after 31 days
since installation.

% License Mot Found

Launchine the Wind River Debue Server (DFW) Backend failed to obtain the
licenze: Overall Licenze for the Wind River Workbench

Feature haz expired

Feature: W WIRKEBEMZH

Expire date:  31-may-2010

License path: CH¥WRECWE|icense¥awrzLicenze lic,C¥WRECYM =¥ |icenze;
CEMOP_B¥license G ELS ECHECYYE license GO P license G¥Wind River -
¥licenze, ¥ Wind River¥licenze¥anrz Licenze lic ¥ licenze¥WRS Licenze.lic

FLEXIm error: —10,32

For further information, refer to the FLEXIm End User Manual,

available at “wenw macrovisioncom” .

| Betry |[ Cance!

(a) How to recover from the error

Acquire a permanent license and overwrite the file to use CW Workbench.
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(2) Use of an illegal license

If there is an error in host information to be registered when a permanent license is acquired, the following license
error message appears.

Point />

When "DISK" is selected and a DISK serial number other than the one on the C drive is specified on the Permanent License
Application Form, the same error occurs.

Enter a DISK serial number on the C drive for the Host ID.

When there are multiple drives on the development environment (personal computer) in use, do not enter a DISK serial
number other than the one on the C drive for the Host ID.

% License Mot Found

Launchine the Wind River Debug Server (DFW) Backend failed to obtain the
licenze: Overall Licenze for the Wind River Warkbench

Iwalid host

The hoztid of this svstem doss not match the hostid

zpecified in the licenze file

Feature: R MIOREBENCH

Hostid: 00000000002k

Lizenze path: C¥WindRiver#licenze¥WRSLicenze lic W RECWMY 2% license;
CEWRECYY A icenzeCEWOP_B¥license,CG¥MELS ECEC A licenze CntOR -
¥licenze CEWind River¥licenzefawrzLicenze licc ¥ license¥WRSLicenze. lic

FLEXIm errar: -957

For further infaormation, refer to the FLEXIm End User Manual,

available at T macrovizion.com”

i Betry |[ Zancel

(a) How to recover from the error
Recheck the Host ID of the personal computer where CW Workbench is being used.
* If the Host ID is wrong:
Apply for license transfer using License Transfer Certification Agreement Form in
PermanentLicenseApplicationForm.xlIsx stored in the DVD-ROM. The Host ID to enter here is as follows:
Enter the wrong Host ID registered last time for "Previous License".

Enter a new Host ID to be registered this time for "New License".
* If the Host ID is correct:

Contact your local Mitsubishi service center or representative.
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(3) Use of a file without license

When CW Workbench has been installed using an install key, the following dialog box appears at the startup of
CW Workbench.

Click the  Cancel | button to start CW Workbench. After the startup, the following license error message
appears.
+ Dialog box

FLEXIm License Finder X

*r'our application was not able to obtain a licensze
becausze the FLE®Im lizense manager could nat
determing where ta find the licenzing data it
needs. Pleaze chooze one of the fallowing:

() Specify the License Server
() Specify the License File

Copyright [c] 1933, 2003 M acrovision Corporation

* License error message

% License Hot Found

River Wiorkbench

Invalid licenze file syntax

Feature: W WIRKBENCH

Licenze path: C3Windr ver¥license¥zwrs License lic, ¥ PElicense;
c¥¥|icenze¥WHRS Licensze. lic

FLEXIm error: —2413. Svstem Error 277

For further information, refer to the FLEXIm End User Manual,

available at “wanw macrovisioncom”
. Retry | [ Zancel

@ Wiarkbench build failed to obtain the license: Overall Licenze for the Wind

$10413 9Sud2| g XIpuaddy

(a) How to recover from the error
Apply for a permanent license. After acquiring a permanent license file, apply it to the development
environment (personal computer).

sainpadsoid A1anooal pue sabessaw Jo4id asuadl| ulepy ¢z xipuaddy
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Appendix 3 comparison with Wind River Workbench

The following table shows the comparison between this product (SW1DND-CWWLQ12-E, SW1DND-CWWLQ24-E)
and Wind River Workbench.

Appendix 3.1 cComparison with SW1DND-CWWLQ12-E

O: Applicable, X: Not applicable

CW Workbench Wind River
Item (SW1DND- Workbench
CWWLQ12-E) 2.6.1
Windows 11 (Home, Pro, Enterprise, Education)

Operating system O X
Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB)

Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.2
SH7750gnule (Compiler for C Controller module (GCC for SH-4A Little Endian o o
compiler)

Compiler
SIMNTgnu (Compiler for VxSim) (GCC for VxWorks Simulator Windows % o
compiler))

Project system and ) .

build system (Project VxWorks Downloadable Kernel Module Project (A project used for normal

. 4 ! application development. Applications which are executed in the kernel mode of @] O
creation and
VxWorks 6.x are created)
management)
Wind River VxWorks Simulator (A simulation function to execute debugging by
Debugger running the Wind River VxWorks application on the operating system without X O
the actual devices)
MemScope (Specify memory leaks by monitoring the memory usage.)
ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)
Runtime analysis tool | StethoScope (Analyze memory leaks by monitoring variables and data x o

structures in real time.)

System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)
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Appendix 3.2 comparison with SW1DND-CWWLQ24-E

O: Applicable, X: Not applicable

CW Workbench 5 X
Wind River
Item (SW1DND-
Workbench 3.2
CWWLQ24-E)
Windows 11 (Home, Pro, Enterprise, Education)
Operating system O X
Windows 10 (Home, Pro, Enterprise, Education, loT Enterprise 2016 LTSB)
Framework Eclipse (Workbench basic function) Ver.3.5 Ver.3.5
PENTIUM4gnu (Compiler for C Controller module (GCC for Intel Atom Z5xx
. o o A
compiler))
Compiler
SIMNTgnu (Compiler for VxSim (GCC for VxWorks Simulator Windows « o
compiler))
Wind River VxWorks Simulator (A simulation function to execute debugging by
running the Wind River VxWorks application on the operating system without X O
the actual devices)
Debugger
Dynamic Printf (A function to dynamically insert or cancel the printf statement
when debugging the program without embedding the printf function to the O O
source code with the similar operation as that of the breakpoint)
MemScope (Specify memory leaks by monitoring the memory usage.)
ProfileScope (Analyze bottleneck of tasks by conducting statistical analysis on
coding status.)
Runtime analysis tool | StethoScope (Analyze memory leaks by monitoring variables and data X O
structures in real time.)
System Viewer (Analyze deadlock and task execution order by monitoring
interrupt task status, CPU utilization, etc.)

I-vZOTMMO-ANALMS Uim uosuedwo) z'¢ xipuaddy
UOUSQYIOAN JOATY PUIA Yim uosuedwo) ¢ xipuaddy
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Appendix 4 support

Appendix 4.1 Technical support assistance service regarding C
Controller module

For technical support assistance service regarding C Controller module, refer to the table below.
If you are not sure which type the inquiry belongs to, please contact us. Please note that inquiries other than MELSEC-

related inquiries may not be able to be answered.

Type Inquiry Where to contact

« Functions and specifications of C Controller module

» Specifications and usage of the dedicated function library
provided by Mitsubishi Electric Corporation

MELSEC- « Setting/monitoring tools for the C Controller module, and

related functions and specifications of CW Workbench

« Functions and specifications of the Mitsubishi products to
be used with C Controller module (such as units and

[Z_ 5 Information and services
For further information and services, please consult your
local Mitsubishi representative

MELSOFT)
« Functions and specifications of VxWorks, API functions
Operating provided by VxWorks, and general inquiries regarding ) )
; Wind River Systems, Inc.
system- programming related to VxWorks oo
. . . . URL: www.windriver.com
related « Functions and specifications of Wind River Workbench and
Tornado
Plug-in L . . ;
« Inquiries regarding the plug-in software to be used with CW )
software- . . Plug-in software manufacturer
related Workbench or Wind River Workbench
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This manual confers no industrial rights or any rights of any other kind, nor does it confer any patent licenses.
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occur as a result of using the contents noted in this manual.
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INFORMATION AND SERVICES

For further information and services, please contact your local Mitsubishi Electric sales office or representative.
Visit our website to find our locations worldwide.

MITSUBISHI ELECTRIC Factory Automation Global Website
Locations Worldwide
www.MitsubishiElectric.com/fa/about-us/overseas/

TRADEMARKS

Microsoft and Windows are trademarks of the Microsoft group of companies.

Intel and Pentium are either registered trademarks or trademarks of Intel Corporation in the United States and/or other
countries.

Oracle and Java are registered trademarks of Oracle and/or its affiliates.

VxSim, VxWorks, and Wind River are either registered trademarks or trademarks of Wind River Systems, Inc.

Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United
States and/or other countries.

The company names, system names and product names mentioned in this manual are either registered trademarks or

trademarks of their respective companies.

®

In some cases, trademark symbols such as '™' or ™" are not specified in this manual.

COPYRIGHTS

The screens (screenshots) are used in accordance with the Microsoft Corporation guideline.
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